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まえがき
はじめに

本章では、PICkit 3™ インサーキット デバッガ / プログラマを使い始める前に知って
おくと便利な一般情報を提供します。主な内容は下記の通りです。

• 本書の構成

• 本書の表記規則

• 推奨参考資料

お客様へのご注意

全ての文書の内容は時間と共に古くなります。本書も例外ではありません。Microchip 社のツール
とマニュアルはお客様のニーズを満たすために常に改良を重ねており、実際のダイアログやツール
の内容が本書に記載されているものと異なる場合があります。最新の文書は弊社ウェブサイト
(www.microchip.com) をご覧ください。

文書は「DS」番号で識別します。この識別番号は、各ページのフッタ部分、ページ番号の前に記載
しています。DS 番号の表記規則は「DSXXXXXA」で、「XXXXX」が文書番号、「A」が文書のリビ
ジョンレベルを表しています。

開発ツールの最新情報は、MPLAB® X IDE のオンラインヘルプをご覧ください。[Help] メニューから
[Topics] を選択すると、オンラインヘルプ ファイルのリストが表示されます。
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本書の構成

本書では、PICkit 3 を開発ツールとして使い、ターゲットボード上のファームウェア
のエミュレーションとデバッグを実行する方法、並びにデバイスのプログラム方法を
説明します。以下に本書の構成を示します。

第 1 部 - 入門編

• Chapter 1. インサーキット デバッガ / プログラマについて
PICkit 3 を紹介し、これをアプリケーションの開発に役立てる方法を説明します。

• Chapter 2. 動作
PICkit 3 の動作原理を説明します。設定オプションも説明します。

• Chapter 3. デバッガの使い方
インストールと設定、一般的なデバッグ機能、ターゲットの使用、MPLAB® 統合開
発環境 (IDE) の設定、関連するデバッガのトピックについて説明します。

• Chapter 4.PICkit 3 Debug Express
PICkit 3 Debug Express の基本的な使い方を説明します。

• Chapter 5.PICkit 3 Programmer-To-Go
PC に接続せずに PICkit 3 でデバイスをプログラムする手順を説明します。

第 2 部 - トラブルシュート

• Chapter 6. トラブルシュートの最初のステップ - デバッガの動作に問題がある場合
に最初に試すべき項目を説明します。

• Chapter 7. よく寄せられる質問 (FAQ) - トラブルシュートに役立つ、よく寄せられ
る質問の一覧を示します。

• Chapter 8. エラーメッセージ - エラーメッセージと、推奨している解決方法の一覧
を示します。

• Chapter 9. エンジニアリング技術ノート (ETN)

第 3 部 - リファレンス

• 補遺A.ハードウェア仕様 - デバッグシステムのハードウェア仕様と電気的仕様を示
します。

• 補遺 B.PICkit 3 の回路図

• 補遺 C. 改訂履歴
DS52116A_JP - p.8  2014 Microchip Technology Inc.



本書の表記規則

本書では以下の表記規則を適用します。

本書の表記規則

表記 意味 例

Arial、MS ゴシックフォント :

二重かぎカッコ : 『』 参考資料 『MPLAB® IDE ユーザガイド』

テキストの強調 ... は唯一のコンパイラです ...

角カッコ : [ ] ウィンドウ名 [Output] ウィンドウ

ダイアログ名 [Settings] ダイアログ

メニューの選択肢 [Enable Programmer] を選択

かぎカッコ : 「 」 ウィンドウまたはダイアログ
のフィールド名

「Save project before build」

右山カッコ (>)を使い、角カッコ
で囲まれた下線付きテキスト

メニューパス [File]>[Save]

角カッコで囲んだ太字の
テキスト

ダイアログのボタン [OK] をクリックする

タブ [Power] タブをクリックする

N'Rnnnn Verilog 形式の数値 : N は総桁
数、R は基数、n は各桁の値

4'b0010, 2'hF1

山カッコで囲まれたテキスト :
 < >

キーボードのキー <Enter>、<F1> を押す

Courier New フォント :

標準の Courier New サンプル ソースコード #define START

ファイル名 autoexec.bat

ファイルパス c:\mcc18\h

キーワード _asm, _endasm, static

コマンドライン オプション -Opa+, -Opa-

ビット値 0, 1

定数 0xFF, 'A'

斜体 変数の引数 file.o (fileは有効な任意
のファイル名 )

角カッコ : [ ] オプションの引数 mcc18 [options] file 
[options]

中カッコとパイプ文字 : { | } どちらかの引数を選択する
場合 (OR 選択 )

errorlevel {0|1}

省略記号 ... 繰り返されるテキスト var_name [, 
var_name...]

ユーザが定義するコード void main (void)
{ ...
}
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推奨参考資料

本書は、PICkit 3 の使い方を説明したものです。その他の便利な文書を、以下に一覧で
ご紹介します。以下に記載した Microchip 社の文書を推奨します。

Multi-Tool Design Advisory (DS51764)

まず、この文書を最初にお読みください。この文書には、PICkit を使う際に注意すべき
重要な情報を記載しています。

PICkit 3 のリリースノート

PICkit 3 の使い方に関する最新情報は、[Start Page] の [Release Notes and Support
Documentation] のリリースノートをお読みください。リリースノートには、ユーザガ
イドには反映されていない最新情報と既知の問題を記載しています。

MPLAB X - Using PICkit 3 In-Circuit Debugger Poster (DS52010)

このシートには、標準通信とターゲットボードを使って PICkit 3 プログラマ / デバッガ
を使うためのハードウェアの接続方法とソフトウェアのインストール方法を記載し
ています。

PICkit 3 インサーキット デバッガ / プログラマ オンラインヘルプ ファイル

MPLAB X IDE はデバッガに関するヘルプファイルを備えています。使い方、トラブル
シュート、ハードウェア仕様を記載しています。印刷された文書よりも新しい情報を
含んでいる可能性があります。さらに、各種デバイスの制約事項の一覧も収めています。

Processor Extension Pak and Header Specification (DS51292)

この文書では、ピンまたはリソースを無駄に専有せずにデバイスを適切にデバッグする
ための、デバッグヘッダの取り付け方法と使い方を説明しています。プロセッサ拡張
パックとヘッダのオンラインヘルプ ファイルも参照してください。

Transition Socket Specification (DS51194)

ヘッダと一緒に使う変換ソケットに関する情報は、この資料を参照してください。
DS52116A_JP - p.10  2014 Microchip Technology Inc.
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Chapter 1.  インサーキット デバッガ / プログラマについて
1.1 はじめに

ここでは、PICkit™ 3 インサーキット デバッガ / プログラマの概要を説明します。

• PICkit 3 インサーキット デバッガ / プログラマについて

• PICkit 3 インサーキット デバッガ / プログラマの機能

• PICkit 3 インサーキット デバッガ / プログラマの構成要素

1.2 PICkit 3 インサーキット デバッガ / プログラマについて

PICkit 3 インサーキット デバッガ / プログラマ ( 図 1-1 参照 ) はシンプルかつ低コス
トなインサーキット デバッガで、Windows® で動作する MPLABX IDE ソフトウェア
を使って操作します。PICkit 3 インサーキット デバッガ / プログラマは、開発エンジ
ニアにとって欠かせないツールの 1 つです。ソフトウェアの開発からハードウェアの
統合まで、幅広い用途に対応します。

PICkit 3 インサーキット デバッガ / プログラマは、インサーキット シリアル プログ
ラミング ™ (ICSP™) と拡張 ICSP の 2 線式シリアル インターフェイスを使って、
Microchip 社の PIC® MCU と dsPIC® DSC 向けのハードウェア / ソフトウェアの開発
を行えるデバッガシステムです。

PICkit 3 インサーキット デバッガ / プログラマは、デバッガとしてだけでなく開発プ
ログラマとしても使えます。

PICkit 3 デバッガは、デバッグ機能を内蔵した組み込みプロセッサのプログラムとデ
バッグ用に開発しました。PICkit 3 の主な特長は以下の通りです。

• Windows 標準ドライバでフルスピード USB をサポート

• リアルタイム実行

• プロセッサが最大速度で動作可能

• 過電圧 / 短絡監視機能を内蔵

• 低電圧～ 5 V ( レンジ : 1.8 ～ 5 V)

• LED インジケータ (POWER、ACTIVE、STATUS)

• マイクロコントローラのプログラムメモリとデータメモリの読み書き

• 全種類のメモリ (EEPROM、ID、コンフィグレーション、プログラム ) の消去と
ベリファイ

• ブレークポイントでの周辺モジュールのフリーズ

Note: PICkit 3 インサーキット デバッガ / プログラマは、量産プログラマではあ
りません。開発専用です。
 2014 Microchip Technology Inc. DS52116A_JP - p.13
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図 1-1: PICkit™ 3 MCU インサーキット デバッガ / プログラマ

1.2.1 ストラップ用ループ

ストラップ用ループを取り付け具として使い、PICkit 3 を吊るしたり身に着けたりで
きます。

1.2.2 USB ポート

USB mini-BコネクタタイプのUSBポートです。付属のUSBケーブルを使ってPICkit 3
を PC に接続します。

1.2.3 1 ピンマーカー

コネクタの向きを合わせる目印として、1 ピンの位置を示しています。

6

21

3

4

凡例 :

1 – ストラップ用ループ

2 – USB ポート

3 – 1 ピンマーカー

4 – プログラミング コネクタ

5 – インジケータ LED

6 – プッシュボタン

5
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インサーキット デバッガ / プログラマについて
1.2.4 プログラミング コネクタ

ターゲット デバイスと接続するための 6 ピンヘッダ (0.100 インチ間隔 ) です。ピン
配置は図 1-2 を参照してください。

図 1-2: PICkit™ 3 プログラマのコネクタのピン配置

1.2.5 インジケータ LED

インジケータ LED は、PICkit 3 の動作ステータスを表示します。

1. POWER ( 緑 ) - PICkit 3 に USB ポートから電源が供給されています。

2. ACTIVE ( 青 ) - PC の USB ポートに接続されて通信リンクがアクティブです。

3. STATUS (3 色のいずれか )

正常 ( 緑 ) - 開始する準備が整ったか、正常に完了しました。

ビジー ( オレンジ ) - プログラミング等の動作を実行中です。

エラー ( 赤 ) - エラーが発生しました。

1.2.6 プッシュボタン

このプッシュボタンは、Programmer-To-Go 機能で使います。 Chapter 5.「PICkit 3 
Programmer-To-Go」を参照してください。

1
2
3
4
5
6

*  6 ピンヘッダ (0.100 インチ間隔 ) は 0.025 インチ角型ピンに適合します。

Pin Description*

1 = MCLR/VPP

2 = VDD Target

3 = VSS (ground)

4 = PGD (ICSPDAT)

5 = PGC (ICSPCLK)

6 = PGM (LVP)

Pin 1 Indicator

Note: シリアル EEPROM デバイスのプログラミング時は、異なるプログラミン
グ コネクタのピン配置が必要です。このタイプのデバイスのピン配置は、
MPLAB X IDE ソフトウェアに付属する PICkit 3 の ReadMe ファイルに記
載しています (MPLAB X IDEの [Start Page]で [Release Notes and Support
Documentation] をクリック )。

Note: 点滅する LED は、その他の情報を示します。詳細は表 5-2 を参照してく
ださい。
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1.3 PICkit 3 インサーキット デバッガ / プログラマの機能

PICkit 3 インサーキット デバッガ / プログラマで以下が可能です。

• 実際のハードウェアでのアプリケーションのリアルタイム デバッグ

• ハードウェア ブレークポイント使ったデバッグ

• 内部イベントに基づいたブレークポイント設定

• 内部ファイルレジスタの監視

• フルスピードでのエミュレート

• デバイスのプログラム

1.4 PICkit 3 インサーキット デバッガ / プログラマの構成要素

PICkit 3 インサーキット デバッガ / プログラマは、以下の構成要素を含みます。

1. PICkit 3 (POWER、ACTIVE、STATUS インジケータ付き )

2. USB ケーブル ( デバッガと PC 間の通信と、デバッガへの電源供給用 )

図 1-3: デバッガの構成要素

その他の製品も別途ご注文頂けます。

• 以下を含む PICkit 3 Debug Express Kit:

- PIC18F45K20 MCU を実装した 44 ピン デモボード

- PIC18 MCU 用 MPLAB C コンパイラ (Free Version)

- 分かりやすいレッスンとチュートリアル

- その他のソフトウェア ユーティリティ、サンプルコード ( ソースコード付き )、
文書一式

• 変換ソケット

• ICD ヘッダ

• MPLAB X IDE プロセッサ拡張キット

PICkit 3

To Target Board

USB Cable to PC

Indicator
Lights
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Chapter 2.  動作
2.1 はじめに

ここでは、PICkit 3 インサーキット デバッガ / プログラマの動作を簡単に説明します。
ここでの目的は、PICkit 3 デバッガ / プログラマを使ってデバッグとプログラミング
を行えるよう、ターゲットボードの設計に必要な情報を提供する事にあります。また、
万一問題が発生してもすぐに解決できるように、インサーキット デバッグとプログラ
ミングの基本的な動作原理を説明します。

• ツールの比較

• PICkit 3 と PICkit  2

• デバッガとターゲットの通信

• 通信の接続

• デバッグ

• デバッグのための要件

• プログラミング

• デバッガが使うリソース
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2.2 ツールの比較

下表に示す通り、PICkit 3 インサーキット デバッガ / プログラマは、Microchip 社の
他のデバッグツールとは物理的、動作的に異なります。機能はデバイスによって異な
る場合があります ( オンラインヘルプ ファイルの [Device and Feature Support] を
参照してください )。

2.3 PICkit 3 と PICkit  2

PICkit 3 インサーキット デバッガ / プログラマは PICkit 2 インサーキット デバッガと
似ています。

これら 2 つのデバッガの似ている点は以下の通りです。

• PC から USB ケーブルで電源を供給する

• 供給する電源電圧値を設定できる

PICkit 2 にはなく、PICkit 3 で追加された機能は以下の通りです。

• 拡張 EE プログラム イメージ空間 (512 KB)

• 正確な参照電圧

• 電圧レンジが広くなった (1.8 ～ 5 V VDD、1.8 ～ 14 V VPP)

表 2-1: デバッグツールの比較

機能
PICkit 3 プログラマ /

デバッガ

MPLAB ICD 3
インサーキット

デバッガ

MPLAB REAL ICE
インサーキット
エミュレータ

USB スピード フルスピードのみ ハイスピード /
フルスピード

ハイスピード /
フルスピード

USB ドライバ HID Microchip Microchip

USB バスパワー動作 Yes Yes Yes

ターゲットへの給電 Yes Yes No

プログラマブル VPP と VDD Yes Yes Yes

ターゲット Vdd からの
ドレイン電流

20 mA <1 mA <1 mA

過電圧 / 過電流保護 Yes (SW) Yes (HW) Yes (HW)

デバイス エミュレーション フルスピード フルスピード フルスピード

ハードウェア ブレーク
ポイント

単純 複合 複合

ストップウォッチ Yes Yes Yes

ソフトウェア ブレーク
ポイント

No Yes Yes

プログラム イメージ 512 KB No No

シリアライズド USB Yes Yes Yes

トレース No No Yes

データキャプチャ No No Yes

ロジックプローブ トリガ No No Yes

高速 /LVDS 接続 No No Yes

量産プログラマ No Yes Yes
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2.4 デバッガとターゲットの通信

ここでは、デバッガの構成を説明します。

標準 ICSP による通信

PICkit 3 デバッガは、標準 ICSP 通信によるプログラミングとデバッグが可能です。
この 6 ピン接続は、従来の PICkit 2 開発用プログラマ / デバッガで使っていたものと
同じです。

モジュラケーブルは、以下のどちらかに挿入できます。

• デバイスがターゲットボードに実装済みの場合はターゲットボードの対応ソケット
( 図 2-1)

• ターゲットボードに標準のアダプタ / ヘッダボード コンボ ( プロセッサパックとし
て提供 ) を接続している場合はアダプタ / ヘッダボード ( 図 2-2)

標準通信の詳細は、補遺 A.「ハードウェア仕様」を参照してください。

図 2-1: 標準のデバッガ ― ICE 回路内蔵デバイスの場合

CAUTION

ソフトウェアをインストールしてからハードウェアを接続します。ソフトウェア
とUSBドライバをインストールする前に、ハードウェアを接続しないでください。

PICkit 3 またはターゲットに電源を供給している時にハードウェア接続を変更し

ないでください。

Note: 旧式のヘッダボードは 6 ピンシングル インライン コネクタではなく 6
ピンのモジュラコネクタを使っているため、AC164110 ICSP アダプタを
使ってデバッガと接続します。

Target Device

or PIM

Power

PICkit 3

Mini-USB

to PC 
cable

Target Board
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図 2-2: 標準のデバッガ ― ICE の場合

Target BoardTransition Socket

Device-ICE

AC164110
Adapter

Header

Power

PICkit 3

Mini-USB

to PC 
cable
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2.5 通信の接続

2.5.1 標準通信ターゲットとの接続

2.5.1.1 インライン コネクタを使う場合

6 ピンのインライン コネクタを使って PICkit 3 インサーキット デバッガ / プログラマ
とターゲットボードのコネクタを接続します ( 図 2-1 参照 )。表 2-2 とセクション A.6

「標準通信ハードウェア」も参照してください。

2.5.1.2 アダプタを使う場合

PICkit 3インサーキット デバッガ /プログラマとターゲット デバイスの間にAC164110
アダプタを使って、6 芯のモジュラ インターフェイス ケーブルで接続します。図 2-3
に、ターゲット PC ボードの裏面から見たコネクタのピン番号を示します。

図 2-3: ターゲット側の標準 RJ-11 接続部

表 2-2: ターゲット側コネクタのピン配置

コネクタのピン番号 マイクロコントローラのピン

1 MCLR/VPP

2 VDD

3 グランド

4 PGD (ICSPDAT)

5 PGC (ICSPCLK)

6 PGM (LVP)

Note: デバッガとターゲットをケーブルで接続すると、反対のピン番号どうし
が結線されます。つまり、ケーブルの片方の 1 ピンは、もう片方の 6 ピン
に接続されます。セクション A.6.2.3「モジュラケーブルの仕様」を参照
してください。

1

2

3

4

5

6

Target
Connector

Target

Bottom Side
PC BoardVPP/MCLR

Vss

PGC
VDD

PGD
LVP
 2014 Microchip Technology Inc. DS52116A_JP - p.21



MPLAB® X PICkit™ 3 ユーザガイド
2.5.2 ターゲット回路との接続

図 2-4 に、PICkit 3 インサーキット デバッガ / プログラマとターゲットボード上のコ
ネクタの配線を示します。この図では、コネクタからターゲットのプリント基板上の
デバイスまでの配線も示しています。VPP/MCLR ラインから VDD へのプルアップ抵
抗 ( 約 10 k typ.) を接続する事を推奨します。これによって、このラインを Low に
ストローブしてデバイスをリセットできます。

図 2-4: ターゲット回路との標準接続

2.5.3 ターゲットの自己給電

以下の説明では、1 ピン (VPP/MCLR)、5 ピン (PGC)、4 ピン (PGD) の 3 つのライン
のみがアクティブで、基本的なデバッガの動作に関係します。参考までに図 2-4 には、
2 ピン (VDD) と 3 ピン (VSS) も示しています。PICkit 3 では、ターゲット デバイスの
電源をデバッガから供給する構成と、ターゲット側に外付けの電源を使う構成の 2 種
類が可能です。

ターゲット アプリケーションの外付け電源を使う方法を推奨します。この構成では、
デバッガがターゲットの VDD を検出して、ターゲットが低電圧動作の場合にレベル
変換を実行します。デバッガが VDD ライン ( インターフェイス コネクタの 2 ピン ) の
電圧を検出できない場合、デバッガは動作しません。

2.5.4 デバッガから電源を供給する場合

デバッガの内部電源は 30 mA までに制限されています。この電源供給方法は、デバ
イスの VDD が他のアプリケーション回路から分離されて独立プログラミングを行え
るような非常に小規模のアプリケーションには適しています。しかし、USB バスパ
ワーとして PC から流れる電流が大きくなるため、一般的な用途には推奨しません。

デバイスによっては AVDD ラインと AVSS ラインがない場合もありますが、これらの
ラインがターゲット デバイスにある場合、デバッガが動作するにはこれらを全て適切
なレベルに接続する必要があります。フローティングのままにする事はできません。

また、VCAP ラインのあるデバイス ( 例 : PIC18FXXJ MCU) は、適切なコンデンサま
たはレベルに接続する必要があります。

VDD

VPP/MCLR

PGC

PGD

VSSAVDD

AVSS

2

1

5

4

3

4.7K-10K

Interface
Connector

Application
PC Board

Device

Note: 配線は非常にシンプルです。問題が発生する場合、これらの重要なライン
に他の接続または部品を取り付けているために PICkit 3 インサーキット
デバッガ/プログラマの正常な動作が妨げられている場合がほとんどです。
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2.5.5 デバッガの正常動作を妨げる回路

図 2-5 は、デバッガのアクティブなラインに PICkit 3 デバッガの正常動作を妨げる部
品を取り付けた様子を示したものです。

図 2-5: 不適切な回路部品

具体的には、以下のガイドラインに従う必要があります。

• PGC/PGD にプルアップ抵抗を使わない - これらのラインはデバッガ内部に 4.7 k
のプルダウン抵抗があるため、プルアップ抵抗を使うと電圧レベルが低下します。

• PGC/PGD にコンデンサを使わない - コンデンサを使うと、プログラミングとデ
バッグの通信の際にデータ / クロックラインの高速遷移を妨げます。

• MCLR にコンデンサを使わない - VPP の高速遷移を妨げます。通常、シンプルなプ
ルアップ抵抗で十分です。

• PGC/PGD にダイオードを使わない - ダイオードを使うと、デバッガとターゲット
デバイスの双方向通信ができません。

No!

No!

No!

No!

VPP/MCLR

PGC

PGD

1

5

4

Interface
Connector
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2.6 デバッグ

PICkit 3 インサーキット デバッガ / プログラマをデバッガとして使うには、2 段階の
手順があります。まず、アプリケーションをターゲット デバイスにプログラムします
( 通常は PICkit 3 をプログラマとして使います )。次に、ターゲットのフラッシュ デバ
イスに内蔵されたインサーキット デバッグ ハードウェアを使ってアプリケーション
プログラムを実行、テストします。これら 2 つの手順は、MPLAB X IDE での以下の
操作に対応しています。

1. コードをターゲットにプログラムし、専用のデバッグ機能を有効にする
( 次セクション参照 )。

2. デバッガを使ってブレークポイントを設定し、実行する。

ターゲット デバイスに正しくプログラムできないと、PICkit 3 インサーキット デバッガ /
プログラマでデバッグを行えません。

図 2-6 に、プログラミングに必要な基本の配線を示します。これは図 2-4 と同じもの
ですが、分かりやすくするためにデバッガの VDD ラインと VSS ラインは省略してい
ます。

図 2-6: プログラミング時の正しい接続 

この図は、PICkit 3 インサーキット デバッガ / プログラマの内部インターフェイス回
路の一部を簡単に示したものです。プログラミング時はターゲット デバイスにクロッ
クは不要ですが、電源の供給は必要です。プログラミングを行う際、デバッガは
VPP/MCLR をプログラミング レベルにし、PGC にクロックパルス、PGD にシリアル
データを送出します。デバイスが正しくプログラムされた事を確認するために、PGC
にクロックを送出して PGD からデータを読み出します。これは、デバイスの ICSP
プロトコルに準拠しています。

+5V

Programming

4.7 k

4.7 k

VPP/MCLR

PGC

PGD

1

5

4

Internal Circuits

VSS

VDD
Voltage
DS52116A_JP - p.24  2014 Microchip Technology Inc.



動作
2.7 デバッグのための要件

PICkit 3 インサーキット デバッガ / プログラマでデバッグ ( 例 : ブレークポイントの
設定、レジスタの参照 ) を行うために、正しく実施する必要のある重要な項目は以下
の通りです。

• デバッガが PC に接続されている必要があります。USB ケーブルを介して PC から
デバッガに電源を供給する事と、USB ケーブルを介して MPLAB X IDE ソフトウェア
とデバッガが通信を行う事が必要です。詳細は Chapter 3.「デバッガの使い方」を
参照してください。

• 図 2-6 に示したように、モジュラ インターフェイス ケーブル ( または同等品 ) を
使ってデバッガをターゲット デバイスの VPP、PGC、PGD ピンに接続する必要が
あります。VSS と VDD もデバッガとターゲット デバイスの間で接続しておく必要
があります。

• ターゲット デバイスに電源を供給している事と、オシレータが正しく動作している
事が必要です。何らかの理由でターゲット デバイスが動作しない場合、PICkit 3 イン
サーキット デバッガ / プログラマでデバッグを行う事はできません。

• ターゲット デバイスのコンフィグレーション ワードが以下に示すように正しくプロ
グラムされている必要があります。

- ターゲットの設計に応じてオシレータのコンフィグレーション ビットを RC、XT
等に対応する値に設定しておく必要があります。

- 一部のデバイスではウォッチドッグ タイマが既定値で有効であるため、無効にす
る必要があります。

- ターゲット デバイスのコード保護を無効にしておく必要があります。

- ターゲット デバイスのテーブル読み出し保護を無効にしておく必要があります。

• PGM (LVP) は無効にしておく必要があります。

上記の条件が満たされている事を確認したら、次の項に進んでください。

• デバッグ開始までの操作手順

• デバッグの詳細

2.7.1 デバッグ開始までの操作手順

デバッグのための要件が満たされている事を前提に、以下の操作は MPLAB X IDE の
メニューから PICkit 3 インサーキット デバッガ / プログラマを現在のツールとして設
定している場合 ([Edit]>[Project Properties]、Hardware Tool) に実行できます。

• [Debug]>[Debug Project] の順に選択し、このセクションの最初で説明した ICSP プロ
トコルを利用してアプリケーション コードをデバイスのメモリに書き込みます。

• ターゲット デバイスのプログラムメモリの上位空間に、小さな「デバッグ実行」
プログラムを読み込みます。デバッグ実行プログラムはプログラムメモリに常駐す
る必要があるため、アプリケーション プログラムはこの予約済み空間を使えません。
デバイスによっては、デバッグ実行プログラム専用の特別なメモリ空間を装備して
います。詳細はデバイスのデータシートで確認してください。

• MPLAB X IDE がターゲット デバイスの「インサーキット デバッグ」専用レジスタ
を有効にします。これにより、デバッガからデバッグ実行プログラムを有効にする
事ができます。デバイスの予約済みリソースの詳細は、セクション 2.9「デバッガ
が使うリソース」を参照してください。

• ターゲット デバイスがデバッグモードで動作します。
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2.7.2 デバッグの詳細

図 2-7 は、デバッグを実行できる状態になった PICkit 3 インサーキット デバッガ / プロ
グラマを示しています。

図 2-7: デバッグの準備が完了した PICkit™ 3 デバッガ

一般に、アプリケーション プログラムが正しく動作するかどうかを確認するには、プロ
グラムコードの最初の方にブレークポイントを設定します。MPLAB X IDE のユーザ
インターフェイスでブレークポイントを設定すると、そのアドレスがターゲット デバ
イス内部のデバッグ専用レジスタに保存されます。PGC と PGD に対するコマンド
は、これらのレジスタと直接通信してブレークポイントのアドレスを設定します。

次に MPLAB X IDE で [Debug]>[Debug Project] を選択します。デバッガが、デバッグ
実行プログラムの実行を命令します。ターゲットはリセットベクタから動作を開始
し、プログラム カウンタが内部デバッグレジスタに保存されたブレークポイントのア
ドレスに達すると実行が停止します。

ブレークポイントのアドレスの命令が実行されると、割り込みと同じようなメカニズ
ムでターゲット デバイスのインサーキット デバッグ メカニズムが「起動」してデバ
イスのプログラム カウンタをデバッグ実行プログラムに転送し、ユーザのアプリケー
ションは停止します。デバッガは PGC と PGD を介してデバッグ実行プログラムと
通信し、ブレークポイントのステータス情報を取得して MPLAB X IDE に返します。
この後、MPLAB X IDE は一連の問い合わせをデバッガに送信し、ファイルレジスタ
の内容や CPU の状態等、ターゲット デバイスに関する情報を取得します。これらの
問い合わせは、最終的にはデバッグ実行プログラムが実行します。

デバッグ実行プログラムは、プログラムメモリ内のアプリケーションと同じように
動作します。一時変数を保存するためにスタックの一部を使います。オシレータが
ない、電源接続が不良、ターゲットボードの短絡等、何らかの理由でデバイスが動
作しない場合、デバッグ実行プログラムと PICkit 3 インサーキット デバッガ / プロ
グラマが通信できず、MPLAB X IDE はエラーメッセージを表示します。
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動作
ブレークポイントを取得するもう 1 つの方法は、[Debug]>[Pause] の選択です。する
と、PGC ラインと PGD ラインが切り換わり、ターゲット デバイスのインサーキッ
ト デバッグ メカニズムの働きにより、プログラム カウンタがプログラムメモリ内の
ユーザコードからデバッグ実行プログラムに切り換わります。この場合もターゲット
アプリケーションのプログラム実行が停止し、MPLAB X IDE はデバッガとデバッグ
実行プログラムの間の通信を利用してターゲット デバイスの状態を問い合わせます。

2.8 プログラミング

PICkit 3 を使ってデバイスをプログラムするには、以下の 3 つの方法があります。

• PICkit 3 と PC を接続し、MPLAB X IDE を使う。

• MPLAB X IDEで設定後、PICkit 3のProgrammer-To-Go機能を使う (詳細はChapter
5.「PICkit 3 Programmer-To-Go」参照 )。

• PICkit 3 プログラマ アプリケーション (MPLAB X IDE を使わずに PICkit 3 でデバイ
スをプログラムするためのソフトウェア)を利用する (詳細は『PICkit 3 Programmer
Application User’s Guide』参照 )。

PICkit 3 をプログラマとして使うと、実際のデバイス ( すなわち、ヘッダボードに装着
された -ICE/-ICD 以外のデバイス ) に対してプログラムできます。PICkit 3 を現在の
ツールとして設定し ([Edit]>[Project Properties]、Hardware Tool)、以下の操作を実行
します。

• [Run]>[Run Project] の順に選択し、ICSP プロトコルを利用してアプリケーション
コードをデバイスのメモリに書き込む。プログラミング中に、クロックは必要あり
ません。また、コードの保護、ウォッチドッグ タイマの有効化、テーブル読み出し
の保護等、プロセッサの全てのモードをプログラムできます。

• 一部のターゲット デバイスでは、プログラムメモリの上位空間に、小さな「プログ
ラム実行」プログラムを読み込みます。これによって、大きなメモリを備えたデバ
イスのプログラミング速度が向上します。

• MPLAB X IDE はターゲット デバイスの「インサーキット デバッグ」専用レジスタ
を、全てのデバッグ機能と共に無効にします。これは、ブレークポイントの設定、
レジスタの内容の参照または変更ができなくなる事を意味します。

• ターゲット デバイスはリリースモードで動作します。プログラマとして使う場合、
デバッガは MCLR ラインをトグルしてターゲットをリセット / 起動する事しか行え
ません。

PICkit 3 インサーキット デバッガ / プログラマは、ICSP を利用してターゲットをプロ
グラムします。VPP、PGC、PGD ラインは、前述した通りに接続してください。プロ
グラミング中に、クロックは必要ありません。また、コード保護、ウォッチドッグ タイ
マ、テーブル読み出し保護等、プロセッサの全てのモードをプログラミングできます。

2.9 デバッガが使うリソース

各デバイスでデバッガが使うリソースを見るには、MPLAB X IDE の [Start Page] で
[Release Notes and Support Documentation]>[Reserved Resources for PICkit 3] をク
リックします。
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Chapter 3.  デバッガの使い方
3.1 はじめに

ここでは、PICkit 3 インサーキット デバッガ / プログラマのインストール方法と使い方
に関する以下のトピックについて説明します。

• インストールと設定

• 一般的なデバッグ機能

• ターゲットの接続

• ターゲットボードの設定

• MPLAB X IDE の設定

• デバッグの開始と停止

• プロセッサメモリとファイルの表示

• エディタに関する詳細は、NetBeans ヘルプの [IDE Basics]>[Basic File Features] を
参照してください。

3.2 インストールと設定

IDE のインストールとデバッガの設定に関する詳細は、ヘルプファイルの [Getting
Started with MPLAB X IDE] を参照してください。

作業手順は以下の通りです。

1. MPLAB X IDE をインストールする。

2. PICkit 3 を PC に接続し、既定値のドライバをインストールする。ターゲットの
接続の詳細は、Chapter 2.「動作」を参照してください。

3. 開発に使う言語ツールスイート / コンパイラをインストールする。

4. MPLAB X IDE を起動する。

5. [New Project] ウィザードを使い ([File]>[New Project])、「PICkit 3」をプロジェクト
に追加する。

6. [Project Properties] ダイアログ ([File]>[Project Properties]) を使ってオプションを
設定する。

7. [Project Properties]ダイアログ ([File]>[Project Properties]、[Hardware tool])を使っ
てプログラミングのツールオプションを設定する。

8. [Run]>[Run Project] を選択してプロジェクトを実行 ( ビルドと実行 ) する。

注意事項 :

1. 各デバッガには一意の識別子が付けられています。OS はこの識別子を認識します。

2. MPLAB X IDE は実行時 (Run または Debug Run) のみハードウェア ツールに接続
します。MPLAB IDE v8 のように常時ハードウェア ツールに接続するには、
[Tools]>[Options]を選択し、[Embedded]ボタンをクリックし、[Generic Settings]
タブで [Keep hardware tool connected] にチェックを入れます。

3. コンフィグレーション ビットを表示できるのは、[Configuration Bits] ウィンドウ
のみです。これらをコードに設定するには、[Window]>[PIC Memory Views] の順
に選択します。次に、[Memory] ドロップダウン リストから [Configuration Bits] を
選択し、[Format] ドロップダウン リストから [Read/Write] を選択して、設定への
アクセスを有効にします。

Note: デバッガがターゲットボードに供給できる最大電流は 100 mA です。
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3.3 一般的なデバッグ機能

デバッグ機能の詳細は、ヘルプファイルの [Getting Started with MPLAB X IDE] の
[Debugging Code] のセクションを参照してください。このセクションは、以下の内容
を含みます。

1. [Debug]>[Debug Project] の選択によるプロジェクトのデバッグ実行 ( ビルド、プロ
グラム、実行 )

2. ブレークポイントの使い方

3. コードのステップ実行

4. [Watches] ウィンドウの使い方

5. メモリ、変数、コールスタックの表示

6. コールグラフの使い方

3.4 ターゲットの接続

PICkit 3 プログラマ / デバッガには、ターゲットとの通信方法を選択するための接続
回路が内蔵されています。詳細と接続図は、セクション 2.4「デバッガとターゲット
の通信」を参照してください。

1. USB/ 電源ケーブルを接続する。

2. デバッガとターゲットを通信ケーブルで接続する (RJ11 プラグを使う場合 ) か、
6 ピン インラインヘッダに直接接続する。

図 3-1: 通信ケーブルと USB/ 電源ケーブルの接続

PICkit 3

To Target BoardUSB Cable to PC
or Header

21
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3.5 ターゲットボードの設定

3.5.1 量産デバイスを使う場合

量産デバイスを使う場合、デバッガをターゲットボードに直接接続します。PICkit 3
インサーキット デバッガ / プログラマでデバッグするには、ターゲットボード上のデ
バイスがデバッグ回路を内蔵している必要があります。必要なデバッグ回路を内蔵し
ているかどうかは、各デバイスのデータシートで確認してください ( デバッグ回路を
内蔵するデバイスには「バックグラウンド デバッガ イネーブル」コンフィグレーショ
ン ビットがあります )。

ターゲットボードには、デバッガで使う通信方法に対応したコネクタが必要です。接
続の詳細は、セクション 2.4「デバッガとターゲットの通信」の「標準 ICSP による
通信」を参照してください。

3.5.2 ICE デバイスを使う場合

ICE デバイスを使う場合、ICE ヘッダボードが必要です。このヘッダボードは、特定
のデバイスまたはデバイスファミリのエミュレーションに必要なハードウェアを実装
しています。ICE ヘッダの詳細は、『Processor Extension Pak and Header Specification』
(DS51292) を参照してください。

ICE ヘッダをターゲットボードに接続するには、変換ソケットを使います。共通の
ヘッダを各種の表面実装パッケージに接続できるように、各種変換ソケットを用意し
ています。変換ソケットの詳細は、『Transition Socket Specification』(DS51194) を参
照してください。

ヘッダボードのレイアウトは、ヘッダまたはプロセッサ拡張パックごとに異なります。
接続の詳細は、セクション 2.4「デバッガとターゲットの通信」の「標準 ICSP によ
る通信」を参照してください。

3.5.3 ICD ヘッダを使う場合

PIC MCU のベースライン全製品と一部のミッドレンジ製品の場合、デバッグ機能を
利用するには特別な「–ICD」デバイスを実装したデバッグ ヘッダボードが必要です。
これらのデバイスの種類と必要な ICD ヘッダボードの製品番号は、『Processor
Extension Pak and Header Specification』(DS51292) を参照してください。『Processor
Extension Pak and Header Specification』は、弊社ウェブサイト (www.microchip.com)
で公開しています。

各 ICD ヘッダボードは「–ICD」デバイスを実装しており、量産デバイスの代わりに
ターゲットボードで使います。しかし、ほとんどのヘッダボードにはデバッグ用の
RJ-11 コネクタが付いており、RJ-11/ICSP アダプタキット (AC164110) を使って
PICkit 3に接続します。図3-2に、PIC18F45K20の ICDヘッダ(AC162061)とAC164110
アダプタキット、少ピン デモボードを使った場合の接続を示します。

多くのミッドレンジ製品、PIC18、16 ビット製品には ICD ヘッダは不要です。ICSP
プログラミング接続で直接デバッグが行えます。

Note: 将来的には、ICD をサポートする回路を内蔵したデバイスも使用可能に
なる予定です。

Note: 将来的には、ICD デバイス ( デバイス名 -ICD) を搭載した ICD ヘッダ
ボードも使用可能になる予定です。
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図 3-2: ICD ヘッダボードの使用

3.5.4 ターゲットへの電源供給

以下に、電源供給方法に関する要点を記します。

• USB 接続を使う場合、PICkit 3 の電源は PC から供給できますが、電流量に制限が
あり、小型のターゲットボードに最大 30 mA (VDD 1.8 ～ 5 V) しか供給できません。

• 推奨するのは、ターゲットで VDD を自給する方法です。この方法だと、より大きな
電流が得られます。もう 1 つの利点として、プラグ & プレイによるターゲット検出
機能が継承される点が挙げられます。つまり、MPLAB X IDE がターゲットとデバ
イスを検出すると、その内容が [Output] ウィンドウに表示されます。

PICkit 3 とターゲットを適切なケーブルで接続します ( セクション 3.4「ターゲットの
接続」参照 )。次に、ターゲットの電源を投入します。PICkit 3 からターゲットに電
源を供給する事もできます。

Note: ターゲット電圧は、ICSP インターフェイスのドライバに対してのみ電源を 
供給します。PICkit 3 には電源供給を行いません。PICkit 3 の電源は USB
ポートからのみ供給されます。
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3.6 MPLAB X IDE の設定

ハードウェアを接続して電源を投入したら、MPLAB X IDE で PICkit 3 インサーキット
デバッガを使えるように設定します。

一部のデバイスでは、コンフィグレーション ビットで通信チャンネルを選択する必要
があります ( 例 : PGC1/EMUC1、PGD1/EMUD1)。ここで選択したピンが、デバイス
に物理的に接続されているピンと同じである事を確認します。

ソフトウェアのインストールとデバッガの設定に関する詳細は、「MPLAB X IDE
Help」を参照してください。

3.7 デバッグの開始と停止 

MPLAB X IDE 内でアプリケーションをデバッグするには、ソースコードを含むプロ
ジェクトを作成する必要があります。プロジェクトを作成すると、以下に示す方法に
従い、コードのビルド、デバイスへのプログラム、実行ができます。

• コードを実行するには、[Debug]>[Debug Project]または [Run]ツールバーの [Debug
Project] のどちらかを選択します。

• コードを停止するには、[Debug]>[Pause] または [Debug] ツールバーの [Pause] の
どちらかを選択します。

• コードの実行を再開するには、[Debug]>[Continue] または [Debug] ツールバーの
[Continue] のどちらかを選択します。

• コードをステップ実行するには、[Debug]>[Step Into] または [Debug] ツールバーの
[Step Into] のどちらかを選択します。スリープ命令をステップ実行しないように注
意してください。エミュレーションを再開するのにプロセッサ リセットを実行する
必要が生じます。

• コード行をステップオーバーするには、[Debug]>[Step Over] または [Debug] ツール
バーの [Step Over] のどちらかを選択します。

• コード実行を終了するには、[Debug]>[Finish Debugger Session] または [Debug]
ツールバーの [Finish Debugger Session] のどちらかを選択します。

• コードに対するプロセッサ リセットを実行するには、[Debug]>[Reset]または [Debug]
ツールバーの [Reset] のどちらかを選択します。デバイスによっては POR/BOR、
MCLR、システムリセット等、上記以外のリセットも実行できます。

3.8 プロセッサメモリとファイルの表示 

MPLAB X IDEには、デバッグ情報や各種プロセッサメモリの情報を表示する複数のウィ
ンドウがあり、[Window] メニューから選択できます。これらのウィンドウの使い方
に関する詳細は、MPLAB X IDE のオンラインヘルプを参照してください。

• [Window]>[PIC Memory Views] - データ (RAM) とコード (ROM) のデバイスメモ
リを表示する。RAM、フラッシュ、特殊機能レジスタ (SFR)、CPU、コンフィグ
レーション ビットから選択する。

• [Window]>[Debugging]  - デバッグ情報を表示する。変数、ウォッチ、コールスタッ
ク、ブレークポイント、ストップウォッチから選択する。

ソースコードを表示するには、[Projects] ウィンドウ内でソースコード ファイルを探
してダブルクリックします。[Files] ウィンドウにソースコードが表示されます。この
ウィンドウには、選択したプロセッサとビルドツールに応じて、色分けされたコード
が表示されます。色分けのスタイルを変更するには、[Tools]>[Options]、[Fonts &
Colors]、[Syntax] タブを選択します。

エディタに関する詳細は、NetBeans ヘルプの [IDE Basics]>[Basic File Features] を参照
してください。
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Chapter 4.  PICkit 3 Debug Express
4.1 はじめに

PICkit 3 Debug Express キットを MPLAB X IDE アプリケーションと組み合わせると、
プログラムの実行、停止、シングルステップ実行を行えます。複数のブレークポイン
トの設定、プロセッサのリセットも可能です。プロセッサを停止すると、レジスタの
内容を観測、変更できます。

MPLAB X IDE の使い方は、以下のマニュアルを参照してください。

•『MPLAB® X IDE User’s Guide』(DS51519)

• MPLAB® X IDE オンラインヘルプ

4.2 PICkit 3 Debug Express キットの内容

PICkit 3 Debug Express キット (DV164131) には、以下のものが含まれます。

1. PICkit 3 インサーキット デバッガ / プログラマ

2. USB ケーブル

3. デバイス実装済みの 44 ピンデモボード

4.3 ハードウェアとソフトウェアのインストール

PICkit 3 のハードウェアとソフトウェアをインストールします。

4.3.1 予約済みリソース

ICD デバイス内蔵のインサーキット デバッグ機能とデバッガの ICSP 機能を使うた
め、PICkit 3 Debug Express はデバッグ実行時、内部リソースの一部を使います。

各デバイスでデバッガが使うリソースの一覧を表示するには、MPLAB X IDE の [Start
Page] で [Release Notes and Support Documentation]>[Reserved Resources for
PICkit 3] をクリックします。

4.3.2 デモボードの接続

44 ピン デモボードに実装されている PIC18F45K20 は、図 4-1 に示すようにデモボー
ドを PICkit 3 に接続するだけでデバッグできます (Explorer 16 ボードを使ったデバッ
グも可能です )。

Note: PICkit 3 Debug Express を使うには、MPLAB IDE バージョン 1.20 以上
が必要です。
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図 4-1: デモボードと PICkit™ 3 の接続

4.3.3 コンフィグレーション ビットと Debug Express

ICD ヘッダなしで直接デバッグが可能な PIC マイクロコントローラには、コンフィグ
レーション ワードに DEBUG ビットがあり、このビットで PIC マイクロコントローラ
のデバッグモードの有効 / 無効を切り換えます。

MPLAB X IDE で PICkit 3 Debug Express を使う場合、このビットは自動的にセット
されるため、ソースコードのコンフィグレーション設定では明示的に指定しないでく
ださい。

PIC24 や dsPIC33 ファミリ等、多くの 16 ビットデバイスには、複数の ICSP プログ
ラミング / デバッグポート ピン ( 例 : PGC1/EMUC1 と PGD1/EMUD1、PGC2/EMUC2
と PGD2/EMUD2) があります。プログラミングの場合は任意の ICSP ポートを使えま
すが、デバッグの場合は一度に 1 つのポートだけがアクティブになります。このアク
ティブな EMU ポートはデバイスのコンフィグレーション ビットで設定します。アク
ティブポートの設定が、PICkit 3 が接続されている EMU ポートに一致していないと、
デバイスはデバッグモードに移行できません。MPLAB X IDE の [Configuration Bits]
ダイアログでは、これらのビットを [Comm Channel Select] ビットと表示します。

CAUTION

通常は、DEBUG コンフィグレーション ビットの値をソースコードのコンフィグ

レーション設定で指定しないでください。指定すると、このデバッガ以外でデバイ
スをプログラムする際にこのビットがアサートされる可能性があります。このビッ
トがアサートされるとアプリケーション回路でデバイスが正しく動作しないか、ま
たは全く動作しなくなります。
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Chapter 5.  PICkit 3 Programmer-To-Go
5.1 はじめに

PICkit 3 Programmer-To-Go を使うと、PIC MCU のメモリイメージを PICkit 3 本体に
ダウンロードして、後で PIC MCU にプログラムできます。つまり、この機能を使う
とソフトウェアまたは PC がなくてもデバイスをプログラムできます。必要なのは
PICkit 3 の USB 電源のみです。

本セクションでは、以下の内容について説明します。

• PICkit 3 Programmer-To-Go の USB 電源

• PICkit 3 Programmer-To-Go 対応デバイス

• PICkit 3 で Programmer-To-Go 機能を使うための設定

• PICkit 3 Programmer-To-Go の使用

• Programmer-To-Go モードの終了

5.2 PICkit 3 Programmer-To-Go の USB 電源

PICkit 3 プログラマ ハードウェアは、ターゲットの ICSP コネクタの VDD ピンから供
給される電源だけでは動作しません。従って、PICkit 3 本体上部の USB mini-B ポー
トから 5 V 電源を供給する必要があります。これには、以下のようにいくつかの方法
があります。

• PC の USB ポートまたは USB ハブのポート ( 通信ではなく電源としてのみ使用 )

• 携帯型機器の USB ホストポート

• USB mini-B コネクタ対応の USB 電源アダプタ / 充電器 ( 自動車のシガレット ライ
ター電源または家庭用コンセントから給電 )

• 携帯電話 / モバイル機器用の USB mini-B コネクタ出力付きポータブル充電器 / 電源

• レギュレートされた5 VをPICkit 3のUSBポートに供給するカスタム バッテリパック

5.2.1 電源要件

USB 電源は以下の条件を満たす必要があります。

• PICkit 3 に 100 mA 以上の電流を供給する事

• レギュレートされた 4.5 ～ 5.5 V の電圧を安定的に出力できる事

Note: PICkit 3 にはプログラマとデバッガの機能がありますが、
Programming-To-Go 機能を利用する場合はプログラマの機能のみが利用
できます。Programming-To-Go ではデバッグ機能は利用できません。

Note 1: ほとんどのバッテリ内蔵型のポータブル充電器 / 電源は、内部のバッテ
リ電圧が低下して出力電圧が 4.5 V を下回った時にその事を示す手段が
ありません。従ってバッテリの残り容量には十分注意し、PICkit 3 に必
ず 4.5 V 以上の電圧が供給されるようにしてください。

2: バッテリ駆動型の電源は、使わない時は PICkit 3 から外しておきます。
PICkit 3 に接続したままにしておくとバッテリが消耗します。
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5.3 PICkit 3 Programmer-To-Go 対応デバイス

PICkit 3 と MPLAB X IDE がサポートする下記のファミリのデバイスは全て
Programmer-To-Go 機能にも対応しています。表 5-1 に、サポートされるデバイス
ファミリとそれぞれのプログラムメモリの制約を示します。

表 5-1: Programmer-To-Go 対応デバイス

デバイスファミリ 対応デバイス

ベースライン 全て 1

ミッドレンジ 全て 1

PIC18F 全て 1

PIC18 J シリーズ 全て 1

PIC18 K シリーズ 全て 1

PIC24 全て 1,2

dsPIC33 全て 1,2

dsPIC30 全て 1

dsPIC30 SMPS 全て 1

PIC32 全て

Note 1: MPLAB X IDEがサポートする全てのファミリのデバイスをサポートします。
アプリケーションがサポートするデバイス一覧を見るには、MPLAB X IDE
の [Start page] で [Release Notes and Support Documentation]>[Device
Support.htm] をクリックします。メモリ容量の大きいデバイスはサポート
されています。

2: PICkit 3のProgrammer-To-Go機能では、これらのデバイスの拡張 ICSP
(Programming Executive) は使えません。これらのデバイスで PICkit 3
の Programmer-To-Go 機能を利用する場合、通常の ICSP でプログラ
ミングが行われます。
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5.4 PICkit 3 で Programmer-To-Go 機能を使うための設定

メモリイメージをPICkit 3 にダウンロードしてProgrammer-To-Go 機能を利用する前
に、PICkit 3 プログラマのソフトウェア オプションとバッファを Programmer-To-Go
用に設定する必要があります。必要なオプションを全て設定してまずソフトウェアか
らターゲット デバイスにプログラミングを実行し、デバイスに正しくプログラミング
が行える事を確認してからProgrammer-To-Go用にイメージをダウンロードする事を
強く推奨します。MPLAB X IDE を使ってデバイスをプログラムする方法は、MPLAB
X IDE のオンラインヘルプを参照してください。

5.4.1 Programmer-To-Go の設定

MPLAB X IDE で、以下の手順に従って Programmer-To-Go 機能を設定します。

1. プロジェクトをクリックして、[File]>[Project Properties] を選択する。ハードウェア
ツールの領域で、プロジェクトで使う PICkit 3 のシリアル番号をクリックする。
[Apply] をクリックする。

図 5-1: PICkit 3 プロジェクトのプロパティ

2. ダイアログの左側の [Categories] の下で、[PICkit 3] をクリックする。これで、
[Options categories] ドロップダウン メニューから [Programmer To Go] を選択で
きる ( 図 5-2 参照 )。

Note: PICkit 3 は、量産プログラマではありません。開発専用です。
Programmer-To-Go 機能を使うとフィールドでプログラムが可能となり
ますが、量産用でない事に注意してください。

Note: Programmer-To-Go モードではメモリ保持オプションをサポートしてい
ません。
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3. [Image Name] フィールドには、プログラミング イメージに使う名前を入力する。

図 5-2: イメージに名前を付ける

4. 図 5-3 に示す [Programmer To Go] タブをクリックすると、デバイスのプログラ
ミングに関して選択した設定が表示される。これらの設定を変更する場合、
[Project Properties] ダイアログを使う。

図 5-3: [Programmer-To-Go] タブ

5. [OK] をクリックする。
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5.4.2 PICkit 3 へのダウンロードの完了

[Make and Program Device] アイコンの横の下矢印を使って [Programmer To Go
PICkit3] を選択し ( 図 5-4 参照 )、PICkit 3 へイメージ転送を実行します。イメージが
PICkit 3 に格納されたら、MPLAB X IDE または PC がなくてもデバイスをプログラム
できます。PICkit 3 のボタンを押すだけです。

図 5-4: PICkit 3 へのダウンロード

イメージのダウンロードが完了すると、[Output] ウィンドウにメッセージが表示され
ます。

「PICkit 3 is now in Programmer to go mode. The next time you connect to this unit,
you will have the choice to take it out of Programmer to go mode.」
( これで、PICkit 3 が Programmer-To-Go モードになりました。次にこのユニッ
トに接続した時に、Programmer-To-Go モードを終了する事を選択できます。)

PICkit 3 本体の「ACTIVE」LED が点滅していれば、Programmer-To-Go モードへの
移行が完了して書き込み準備が整った事を示します。

PC の USB ポートから PICkit 3 を取り外します。次に USB ケーブルから PICkit 3 に
電源を供給すると「ACTIVE」LED が点滅し、PICkit 3 が Programmer-To-Go で起動
した事を示します。
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5.5 PICkit 3 Programmer-To-Go の使用

PICkit 3 の Programmer-To-Go の設定完了後、これを使ってターゲット デバイスをプ
ログラムするには、以下の手順に従います。

1. セクション 5.2「PICkit 3 Programmer-To-Go の USB 電源」で説明した方法で、
PICkit 3 に USB 電源を接続する。

2. PICkit 3 本体の「POWER」LED が点灯している事を確認する。PICkit 3 が
Programmer-To-Go モードになり、プログラムする準備が完了すると、「ACTIVE」
LED が 1 回点滅する。

3. PICkit 3 の ICSP コネクタをターゲットに接続する。PICkit 3 から電源を供給しな
い場合、ターゲットに適切に電源が供給されている事を確認する。

4. PICkit 3 のプッシュボタンを押すと、プログラム動作が開始する。

プログラム動作中は、PICkit 3 の「STATUS」LED がオレンジ色に変わり、動作が終
了するまで点灯します。

プログラム動作が終了すると、PICkit 3 の LED がエラーの有無を示します。成功した
場合は「STATUS」LED が緑に点灯します。プログラムエラーがあった場合は赤に点
灯します。表 5-2 に、LED 表示と意味を示します。

表 5-2: Programmer-To-Go 動作後の LED 表示と意味

LED のステータス 意味

「ACTIVE」
LED

「STATUS」 
LED コード 説明

青

1 回点滅

緑 成功 / 準備
完了

プログラム動作中にエラーは発生しませんでした。
PICkit 3 の Programmer-To-Go 機能で再度書き込
みが可能です。

消灯 赤

間隔をあけず
繰り返し点滅 :
••••••••••••••

VDD/VPP

エラー
PICkit 3 が VDD または VPP の電圧を所定の値に設
定できませんでした。
PICkit 3 が VDD を供給していない場合、VPP エ
ラーです。
VDD と VPP の詳細は、セクション 2.5「通信の接
続」を参照してください。

消灯 赤

2 回ずつ
繰り返し点滅 :
•• •• •• •• •• 

デバイスID
エラー

PICkit 3 がターゲットから予測しないデバイス ID
を受信しました。
PICkit 3 の Programmer-To-Go 設定時に選択した
デバイスとターゲット デバイスが一致する事を
確認します。このエラーは、ICSP 接続に問題が
あり PICkit 3 がターゲットと通信できていない事
を示している場合があります。ベースライン デバ
イスではこのエラーは発生しません。

消灯 赤

3 回ずつ
繰り返し点滅 :
••• ••• ••• •••

ベリファイ
エラー

プログラム後にターゲットのベリファイに失敗し
ました。
ターゲットのVDDが要件を満たしている事を確か
めます。ベースライン デバイスの場合、このエ
ラーは ICSP通信の問題を示す可能性があります。

消灯 赤

4 回ずつ
繰り返し点滅 :
•••• •••• ••••

内部エラー Programmer-To-Go で予期しない内部エラーが発
生しました。
このエラーがもう一度発生したら、PICkit 3 へのダ
ウンロードをやり直してみてください。

Note: PICkit 3 のプッシュボタンを押すとエラーコードがクリアされ、新しい
プログラム動作を開始できます。
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5.6 Programmer-To-Go モードの終了

Programmer-To-Go モードを終了するには、PICkit 3 を PC の USB ポートに接続し、
MPLAB X IDE と通信します。[Run]>[Run Project] の順に選択すると、以下のメッセー
ジが表示されます。

「PICkit 3 is in Programmer-to-go mode. The name of the stored image is: ____. Do
you want to stay in Programmer-to-go mode? (Saying no will erase the image in
the PICkit 3.)」
( これで、PICkit 3 が Programmer-To-Go モードになりました。格納されたイメー
ジの名前は ____ です。Programmer-To-Go モードにとどまりますか ?
([No] を選択すると PICkit 3 内のイメージが削除されます ))

[No] を選択するとイメージが削除され、Programmer-To-Go モードを終了します。
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Chapter 6.  トラブルシュートの最初のステップ
6.1 はじめに

PICkit 3 インサーキット デバッガ / プログラマの動作に問題が生じた場合、まずこち
らの内容を確認してください。

• 最初に確認する 5 つの項目

• デバッグに失敗する主な理由

• その他の確認事項

6.2 最初に確認する 5 つの項目

1. 使っているデバイスを確認してください。
新しいデバイスを使う場合、より新しいバージョンの MPLAB X IDE へのアップ
グレードが必要な場合があります。つまり、黄色信号 = 未テストのサポート ( ベータ
サポートレベル ) の場合があるという事です。

2. Microchip 社のデモボードを使っていますか。それともお客様が設計したボード
を使っていますか。
通信の接続に必要な抵抗とコンデンサに関するガイドラインが守られていますか。
Chapter 2.「動作」を参照してください。

3. ターゲットに電源が供給されていますか。
30 mA を超える場合、デバッガからターゲットに電源を供給できません。

4. USB ハブを使っていますか。ハブに電源は供給されていますか。
それでも問題が解決しない場合、ハブを使わずにデバッガを PC に直接接続して
ください。

5. デバッガに付属の標準通信ケーブル (RJ-11) を使っていますか。
これよりも長いケーブルを使った場合、通信エラーが起こる可能性があります。

6.3 デバッグに失敗する主な理由

1. オシレータが動作していない。オシレータに関するコンフィグレーション ビット
の設定を確認してください。
外部オシレータを使っている場合、内部オシレータを試してください。内部 PLL
を使っている場合、PLL の設定が正しい事を確認してください。

2. ターゲットボードに電源が供給されていない。
電源ケーブルの接続を確認してください。

3. VDD 電圧がデバイス仕様外である。
詳細は、デバイスのプログラミング仕様を参照してください。

4. デバッガと PC またはターゲットボードが物理的に接続されていない。
通信ケーブルの接続を確認してください。

5. デバイスがコード保護されている。
コード保護に関するコンフィグレーション ビットの設定を確認してください。

6.  デバッガと PC の通信が中断された。
MPLAB X IDE でデバッガに再接続します。
 2014 Microchip Technology Inc. DS52116A_JP - p.47



MPLAB® X PICkit™ 3 ユーザガイド
7. デバッグしようとしている量産デバイスにデバッグ機能がない。
デバッグヘッダを使ってください (「推奨参考資料」に記載されている『Processor
Extension Pak and Header Specification』参照 )。

8. ターゲット アプリケーションが何らかの理由で破損したか、エラーがある。
例えば、デバッガ版のリンカスクリプトではなく、正規のリンカスクリプトを使っ
た場合です ( 例 : 18F8722i.lkr の代わりに 18F8722.lkr を使用 )。ターゲット アプリ
ケーションを再ビルドしてプログラミングし直してください。その後、ターゲット
のパワーオン リセットを実行します。

9. コンフィグレーション ビットで正しいPGC/PGDピンペアをプログラムしていない
( 複数の PGC/PGD ピンペアを備えたデバイスの場合 )。

10. 他の設定が干渉してデバッグできない。
ターゲットがコードを実行できないようなコンフィグレーション設定が行われて
いると、デバッガはコードをデバッグモードにする事ができません。

11. ブラウンアウト検出電圧が、動作電圧 VDD よりも高い。
この場合、デバイスはリセット状態に移行し、デバッグできません。

12. Chapter 2.「動作」の通信接続のガイドラインに従っていない。

13. デバッガは、要求された動作を常に実行できるわけではありません。
例えばターゲット アプリケーションが実行中の場合、デバッガはブレークポイ
ントを設定できません。

6.4 その他の確認事項

1.  一過性のエラーの場合があります。
同じ操作を繰り返してみてください。

2. プログラミングに関する一般的な問題の可能性もあります。
実行モードに切り換えて、なるべくシンプルなアプリケーション ( 例 : LED 点滅
プログラム)でターゲットへの書き込みテストを行ってください。このアプリケー
ションが動作しない場合、ターゲットの設定に何らかの問題がある事が分かります。

3. ターゲット デバイスが何らかの損傷 ( 例 : 過電流 ) を受けた可能性があります。
開発環境では、電子部品に悪影響が及ぶ事がよくあります。ターゲット デバイス
を別のものに交換してみてください。

4. Microchip 社では、ほとんどのマイクロコントローラをサポートしたデモボード
を用意しています。
PICkit 3 インサーキット デバッガ / プログラマが正しく動作するかどうかを検証
するには、正常動作が確認済みのこれらのボードを使うのも 1 つの方法です。

5. デバッガの動作を確認して、アプリケーションを正しくセットアップしてください。
詳細は、Chapter 2.「動作」を参照してください。

6. それでも解決しない場合は Microchip 社までお問い合わせください。
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Chapter 7.  よく寄せられる質問 (FAQ)
7.1 はじめに
ここでは、PICkit 3 インサーキット デバッガ / プログラマ システムについてよく寄せ
られる質問とその回答を紹介します。

• 動作に関する FAQ

• 不具合に関する FAQ

7.2 動作に関する FAQ

• PICkit 3 インサーキット デバッガ / プログラマは通信にデバイス内のどの機能を利
用しているのですか。

PICkit 3 インサーキット デバッガ / プログラマは、ICSP インターフェイスを介して
フラッシュ デバイスと通信します。そして、プログラムメモリまたはテストメモリ
にダウンロードしたデバッガ実行プログラムを使います。

• デバッグ実行プログラムを動作させるとプロセッサのスループットにどのような
影響がありますか。

デバッガ実行プログラムは実行モードでは動作しないため、コード実行時にスルー
プットの低下はありません。つまり、デバッガがターゲット デバイスの実行サイクル
を「奪う」事はありません。

• PICkit 3 インサーキット デバッガ / プログラマと他のインサーキット エミュレータ /
デバッガにはどのような違いがありますか。

セクション「ツールの比較」を参照してください。

• PICkit 3 インサーキット デバッガ / プログラマには、他のインサーキット エミュ
レータ / デバッガのような複雑なブレークポイントがありますか。

いいえ。しかし、特定のデータメモリ アドレスに格納された値またはプログラム
アドレスに基づいてブレークを実行する事はできます。

• PICkit 3 は光学的または電気的に絶縁されていますか。

いいえ。現在のシステムにフローティング電圧または高電圧 (120 V) を印加する事
はできません。

• 標準ケーブルには何か制約はありますか。

標準の ICSP RJ-11 ケーブルは、15 Mbps を超えるクロック速度には対応していま
せん。

• PICkit 3 によってプログラムの実行速度は低下しますか。

いいえ。デバイスはデータシートに記載されている速度で動作します。

• dsPIC DSC を任意の速度で動作させてデバッグを行う事はできますか。

PICkit 3 は、デバイスのデータシートに記載されている任意の速度でデバイスを動
作させてデバッグを実行できます。

• 6 ピン (LVP ピン ) はどのような働きをしますか。

6 ピンは、LVP (Low-Voltage Programming) 接続用に予約済みです。
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7.3 不具合に関する FAQ

• デバイスのプログラミング後にベリファイを実行すると不合格になります。これは
プログラミングの問題ですか。

実行を選択した場合 ([Run]>[Run Program])、デバイスはプログラミング直後に自動
的に実行を開始します。従って、実行されたコードがフラッシュメモリを書き換え
た場合、ベリファイが失敗する可能性があります。プログラミング後のコード実行
を抑止するには、[Hold in Reset] を選択してください。

• PC が省電力 / 休止モードになった後、デバッガが動作しなくなりました。どうし
たのでしょうか。

デバッガを ( 特にデバッガとして ) 長時間使う場合、お使いの PC のオペレーティン
グ システムの電源オプション設定画面で休止モードを無効にしておいてください。
Windows XP の場合、[ 電源オプションのプロパティ ] ダイアログ ボックスの [ 休止
状態 ] タブで [ 休止状態を有効にする ] のチェックを外します。こうすると、全ての
USB サブシステム コンポーネントで全通信を維持できます。

• 周辺モジュールに [Freeze on Halt] を設定していないのに突然フリーズしてしまい
ます。なぜでしょうか。

dsPIC30F/33F と PIC24F/H の場合、デバッガは周辺制御レジスタの予約済みビット
( 通常は bit 14 または 5) を Freeze ビットとして使います。レジスタ全体に書き込
みを実行した時に、このビットが上書きされた可能性があります ( このビットはデ
バッグモードではユーザアクセス可能です )。

この問題を防ぐには、レジスタ全体を書き換える命令 (MOV) ではなく、アプリケー
ションで変更が必要なビットだけを書き換える命令 (BTS、BTC) を使います。

• 16 ビットデバイスを使用中に、予期しないリセットが発生しました。どのようにす
れば原因を特定できますか。

以下の点を確認してください。

- RCON レジスタを確認してリセット要因を調べる。

- 割り込みサービスルーチン (ISR) でトラップ / 割り込みを処理する。例えば、以
下のような trap.cコードを挿入します。

   void __attribute__((__interrupt__)) _OscillatorFail(void);
          :
   void __attribute__((__interrupt__)) _AltOscillatorFail(void);
          :
   void __attribute__((__interrupt__)) _OscillatorFail(void)
   {
        INTCON1bits.OSCFAIL = 0;        //Clear the trap flag
        while (1);
   }
          :
   void __attribute__((__interrupt__)) _AltOscillatorFail(void)
   {
        INTCON1bits.OSCFAIL = 0;
        while (1);
   }
          :

- アサートを使う。
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よく寄せられる質問 (FAQ)
• コードのデバッグが完了しました。デバイスをプログラムしましたが、動作しません。
何が原因でしょうか。

以下の点を確認してください。

- デバッガをプログラマとして選択してヘッダボードへの書き込みを行いませんで
したか。ヘッダボードに搭載されているのは -ICE/-ICD バージョンのデバイスで、
実際のデバイスとは動作が異なる事があります。デバッガをプログラマとして
使って書き込めるのは、「通常」のデバイスのみです。通常のデバイスにも ICE/ICD
回路を内蔵したデバイスがありますが、ヘッダボードに搭載されている特殊な
-ICE/-ICD デバイスとは別のものです。

- PICkit 3 をデバッガとして選択したままデバイスにプログラミングを行いません
でしたか。PICkit 3 をデバッガとして選択してプログラミングを行うと、デバッ
グ実行プログラムがプログラムメモリに書き込まれ、デバッグ用のその他のデバ
イス機能がセットアップされます ( セクション「デバッグ開始までの操作手順」
参照 )。完成した ( リリース用 ) コードをプログラムする場合、PICkit 3 をプログ
ラマに設定する必要があります。

- [Build Configuration]ドロップダウン リストまたは [Project]メニューで「Release」
を選択しましたか。完成した ( リリース用 ) コードを書き込むには、この操作が
必要です。プロジェクトを再ビルドしてデバイスにもう一度書き込みを行い、コー
ドが動作するかどうか試してみてください。

• どのようにすればファームウェアを手動でダウンロードできますか。

以下のようにして、手動でダウンロードできます。[File]>[Project Properties] を選
択します。[Categories] の下で [PICkit 3] をクリックし、[Option Categories] ド
ロップダウンから [Firmware] を選択します。[Use Latest Firmware] のチェックを
外し、[Press to browse for a specific firmware version] をクリックします。
[MPLABX\mplab_ide\mplablibs\modules\ext\PICKIT3.jar] の下の [Directories]
ウィンドウ枠にある [Firmware File] を参照します。[Firmware Files] ウィンドウ枠
で .jamファイルを選択して、[OK] をクリックします。[Project Properties] ダイ
アログで [Reset] をクリックします。

• ファームウェアのダウンロード中に誤って PICkit 3 を切断してしまいました。対処
の方法を教えてください。

PICkit 3 を再接続します。エミュレータは、再起動できるように書き込み済みの
内容を消去し始めます。この消去には、約 7 秒かかります。完了するまでお待ち
ください。処理中は全ての LED が ON になります。処理が完了すると MPLAB X
IDE はデバイスを認識し、復帰プロセスすなわちファームウェアのダウンロード
を開始します。

• メモリウィンドウに変更が反映されません。

ウィンドウに変更を表示させるには、メモリを読み出す必要があります。

• この「よく寄せられる質問」に記載されていない問題が発生しました。どうすれば
良いでしょうか。

以下を参照してください。

- セクション「デバッガが使うリソース」

- セクション「一般的な対処方法」

- セクション「特定の状況で表示されるエラーメッセージ」

- Chapter 9.「エンジニアリング技術ノート (ETN)」
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Chapter 8.  エラーメッセージ

8.1 はじめに
PICkit 3インサーキット デバッガ/プログラマは各種のエラーメッセージを生成します。
特定の状況で表示されるエラーメッセージもありますが、一般的な対処法で解決でき
るものもあります。 通常、エラーメッセージの下に説明がある場合はそれらをお読み
ください。 説明を読んでも問題を解決できない場合、または説明がない場合、以下の
セクションを参照してください。

• 特定の状況で表示されるエラーメッセージ

• 一般的な対処方法

8.2 特定の状況で表示されるエラーメッセージ

8.2.1 デバッガとターゲット間の通信エラー

Failed to send database ( データベースの送信に失敗しました )

このエラーが表示された場合、以下の解決方法を試してください。

1. もう一度ダウンロードする ( 一過性のエラーの場合があるため )。

2. 最も番号の大きい .jamファイルの手動ダウンロードを試みる。

これらの操作で問題が解決しない場合、セクション「デバッガとターゲットの通信エ
ラーの対処方法」を参照してください。

8.2.2 インストール ファイルの破損 / 期限切れエラー

Failed to download firmware ( ファームウェアのダウンロードに失敗しました )

Hex ファイルが存在する場合、以下の解決方法を試してください。

• 再接続してもう一度試してみる。

• それでも解決しない場合、ファイルが破損している場合があります。 MPLAB X IDE
を再インストールしてください。

Hex ファイルが存在しない場合、以下の解決方法を試してください。

MPLAB X IDE を再インストールする。

Unable to download debug executive ( デバッグ実行プログラムをダウンロードで
きません )

デバッグ時にこのエラーが表示された場合、以下の操作を実行してください。

1. デバッガのデバッグツールとしての選択を解除する。

2. プロジェクトを閉じて MPLAB X IDE を終了する。

3. MPLAB X IDE を再起動して再度プロジェクトを開く。

4. デバッグツールとしてデバッガを選択し、再度ターゲット デバイスをデバッグしてみる。

Unable to download program executive ( プログラム実行ファイルをダウンロード
できません )

プログラムしようとしている時にこのエラーが表示された場合、以下の操作を実行し
てください。

1. デバッガのプログラマとしての選択を解除する。

2. プロジェクトを閉じて MPLAB X IDE を終了する。

3. MPLAB X IDE を再起動して再度プロジェクトを開く。

4. プログラマとしてデバッガを選択し、再度ターゲット デバイスをプログラムしてみる。

これらの操作で問題が解決しない場合、セクション「インストール ファイルが破損し
ている場合の対処方法」を参照してください。
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8.2.3 デバッグ障害のエラー

The target device is not ready for debugging. Please check your configuration bit
settings and program the device before proceeding ( ターゲット デバイス側でデ
バッグの準備ができていません。コンフィグレーション ビットの設定を確認して、デ
バイスをプログラムしてから作業を続けてください )

デバイスをプログラムする前に実行しようとすると、このメッセージが表示されます。
実行を試みた後にこのメッセージが表示された場合、またはデバイスのプログラミン
グ直後にこのメッセージが表示された場合、セクション「デバッグ障害の対処方法」
を参照してください。

The device is code protected ( デバイスはコード保護されています )

操作 ( 読み出し、書き込み、ブランクチェック、ベリファイ ) を行おうとしたデバイ
スのコード保護が有効になっており、コードの読み出しまたは変更が行えません。
コード保護に関するコンフィグレーション ビットの設定を確認してください。

コード保護を無効にするには、デバイスのデータシートを参照して該当するコンフィ
グレーション ビットをコード内または [Configuration Bits]ウィンドウでセットまたは
クリアします。 その後で、デバイス全体を消去してから再プログラムします。

8.2.4 その他のエラー

PICkit 3 is busy. Please wait for the current operation to finish (PICkit 3 がビジー
です。現在の動作が終了するまで待機してください )

PICkit 3 をデバッガまたはプログラマとしての指定から解除しようとしてこのエラー
が表示された場合、以下の解決方法を試してください。

1. デバッガが現在実行中のタスクが終了するまで待つ。 その後、もう一度デバッガの選択解
除を試みる。

2. [Halt] を選択して実行中のアプリケーションを停止する。 その後、もう一度デバッガの選択
解除を試みる。

3. デバッガと PC の接続ケーブルを抜く。 その後、もう一度デバッガの選択解除を試みる。

4. MPLAB X IDE を終了する。

8.3 一般的な対処方法

以下の一般的な対処方法で問題が解決する場合があります。

• 読み書きエラーの対処方法

• デバッガとターゲットの通信エラーの対処方法

• デバッガと PC の通信エラーの対処方法

• インストール ファイルが破損している場合の対処方法

• USB ポート通信エラーの対処方法

• デバッグ障害の対処方法

• 内部エラーの対処方法

8.3.1 読み書きエラーの対処方法

読み書きエラーが発生した場合、以下の事項を確認してください。

1. [Abort] を押しましたか。この操作で読み書きエラーが発生する事があります。

2. 同じ操作を繰り返してみる ( 一過性のエラーの場合があるため )。

3. ターゲットに電源が供給されており、デバイスの電圧レベルが適正である事を確認する。
デバイスに必要な電圧レベルは、各デバイスのデータシートを参照してください。

4. デバッガとターゲットの接続が正しい事 (PGC と PGD が接続されている事 ) を確認する。

5. 書き込みエラーの場合、[Settings] ダイアログの [Program Memory] タブで [Erase all before
Program] にチェックが入っている事を確認する。

6. 使っているケーブルの長さが適切である事を確認する。
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8.3.2 デバッガとターゲットの通信エラーの対処方法

PICkit 3 インサーキット デバッガ / プログラマとターゲット デバイスの同期がとれて
いません。

1. [Reset] を選択してから同じ操作を再試行する。

2. 使っているケーブルの長さが適切である事を確認する。

8.3.3 デバッガと PC の通信エラーの対処方法

PICkit 3 インサーキット デバッガ / プログラマと MPLAB X IDE の同期がとれていま
せん。

1. デバッガと PC の接続ケーブルを一度抜いて挿し直す。

2. デバッガに再接続する。

3. 同じ操作を繰り返してみる ( 一過性のエラーの場合があるため )。

4. インストールされている MPLAB X IDE のバージョンが、PICkit 3 インサーキット デバッ
ガ / プログラマに読み込まれているファームウェアのバージョンに対応していない可能
性がある。 セクション「インストール ファイルが破損している場合の対処方法」の手順に
従う。

8.3.4 インストール ファイルが破損している場合の対処方法

この問題は、ほとんどの場合、MPLAB X IDE のインストールが不完全であるか、イ
ンストールしたファイルが破損した事が原因で発生します。

1. 全てのバージョンの MPLAB X IDE を PC からアンインストールする。

2. 使っているバージョンの MPLAB X IDE を再インストールする。

3. それでも解決しない場合は Microchip 社までお問い合わせください。

8.3.5 USB ポート通信エラーの対処方法

この問題は、ほとんどの場合、通信ポートに問題があるか、存在しない通信ポートを
指定している事が原因で発生します。

1. PICkit 3 インサーキット デバッガ / プログラマを再接続する。

2. デバッガが物理的に PC の適切な USB ポートに接続されている事を確認する。

3. デバッガの [Settings] で適切な USB ポートが選択されている事を確認する。

4. 指定した USB ポートを他のデバイスが使っていない事を確認する。

5. USB ハブを使う場合、電源が供給されている事を確認する。

6. USB ドライバが読み込まれている事を確認する。

8.3.6 デバッグ障害の対処方法

PICkit 3 インサーキット デバッガ / プログラマでデバッグを実行できない場合、 これ
には多くの原因があります。 セクション「デバッグに失敗する主な理由」とセクショ
ン「その他の確認事項」を参照してください。

8.3.7 内部エラーの対処方法

内部エラーは想定外のエラーであり、通常は発生しません。 これらは主に Microchip
社内の開発で使います。

主な原因はインストール ファイルの破損です ( セクション「インストール ファイル
が破損している場合の対処方法」参照 )。

システムリソースの枯渇が原因である可能性もあります。

1. システムを再起動してメモリを解放する。

2. HDD に十分な空き容量がある事、過度なフラグメンテーションが発生していない事を確認
する。

それでも解決しない場合は Microchip 社までお問い合わせください。
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Chapter 9.  エンジニアリング技術ノート (ETN)
PICkit 3 に関連する ETN は、以下の通りです。 詳細は、www.microchip.com のサイ
トで PICkit 3 インサーキット デバッガのページを開き、ダウンロード セクションで
ETN をクリックして参照してください。

• ETN-32 PICkit 3 の低電圧動作に関する改修 : アセンブリ番号 10-00424-R4 またはそれ以下
に適用されます。
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補遺 A. ハードウェア仕様
A.1 はじめに

ここでは、PICkit 3 インサーキット デバッガ / プログラマ システムのハードウェア仕
様と電気的仕様を詳しく説明します。

A.2 ハイライト

この章では以下について説明します。

• 適合宣言書

• USB ポート / 電源

• PICkit 3 インサーキット デバッガ / プログラマ

• 標準通信ハードウェア

• ターゲットボードに関する注意事項

A.3 適合宣言書

当社

Microchip Technology, Inc.
2355 W. Chandler Blvd.
Chandler, Arizona 85224-6199
USA

は、以下の製品

PICkit 3 インサーキット デバッガ / プログラマ

が、操作マニュアルに記載された制限事項を遵守した場合に以下の規格に適合する事
を宣言します。

規格 : EN61010-1 試験所用電気機器
Microchip Technology, Inc.
日付 : 2009 年 1 月

PICkit 3 インサーキット デバッガ / プログラマの使用に関する重要な注意事項

PICkit 3 インサーキット デバッガ / プログラマは、その特殊な性質により、通常より
高いレベルの電磁放射を発生して無線機器等あらゆる種類の機器の動作に影響を与
える事があるため注意してください。

従って、上記欧州規格に適合するためには、以下の制限事項を遵守する必要があります。

1. 本開発システムの使用は工業地域 ( または同等地域 ) のみに限定する事。

2. 無線受信機やテレビ等、電磁波の影響を受ける可能性のある機器から 20 メートル
以内の場所で本システムを使わない事。
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A.4 USB ポート / 電源

PICkit 3 インサーキット デバッガ / プログラマは、mini USB 2.0 ポートを介してホスト
PC に接続します。 USB コネクタはポッドの上部にあります。

システムはUSBインターフェイスを利用してファームウェアを再読み込みできます。

システムの電源は USB インターフェイスから供給します。 このデバッガは USB 仕様
の「ハイパワー システム」に分類され、デバッガモードとプログラマモードのどちら
の場合も 100 mA をやや上回る電力を USB から供給する必要があります。

ケーブル長 ― PC とデバッガを接続するケーブルは、正常動作に適した長さのものを
キットに同梱しています。

セルフパワードハブ ― USB ハブを使う場合、バスパワードではなくセルフパワード
タイプを使います。 PC キーボード内蔵の USB ポートでは、デバッガの動作に十分な
電力が得られません。

PC の休止 / 省電力モード ― USB 接続による PC とデバッガの通信を確保するため、
休止モード等 PC の省電力モードを無効にします。

A.5 PICkit 3 インサーキット デバッガ / プログラマ

デバッガの筐体はメインボードを格納しており、USB コネクタとシングル インライ
ン コネクタが付いています。 デバッガの筐体にはインジケータ ライト (LED) もあり
ます。

A.5.1 メインボード

メインボードには、インターフェイス プロセッサ、USB 2.0 インターフェイス、内蔵
フラッシュ エミュレーション デバイスへのプログラミング用の SPI シリアル EE、イ
ンジケータ LED が実装されています。

A.5.2 インジケータ ライト (LED)

インジケータ ライトの意味は以下の通りです。

Note: PICkit 3 インサーキット デバッガ / プログラマには、USB 接続を介して
電源を供給します。 ターゲットボードには他の専用電源から給電します。 
ただし、ターゲットの消費電流が 30 mA 未満の場合に限り、PICkit 3 か
ら電源を供給する事もできます。

LED カラー 説明

POWER 緑 電源を投入またはターゲットを接続すると点灯します。

ACTIVE 青 PICkit™ 3 と PC の接続が確立されている時、またはコマンド送受信
時に点灯します。

STATUS 緑 デバッガが正常に動作しており、スタンバイ状態の時に点灯します。

橙 動作中 ( ビジー ) の時に点灯します。 

赤 デバッガにエラーが発生すると点灯します。
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A.6 標準通信ハードウェア

デバッガとターゲットの標準通信 ( セクション「デバッガとターゲットの通信」の
「標準 ICSP による通信」) には、RJ-11 コネクタ付きのアダプタを使います。

ヘッダボード使用時に標準通信を行うには、デバイス専用のプロセッサパック
(-ICE/ICD デバイスを装着した 8 ピンコネクタのヘッダボードと標準アダプタボード
のセット ) が必要になる事があります。

利用可能なヘッダボードの詳細は、『Processor Extension Pak and Header Specification』
(DS51292) を参照してください。

A.6.1 標準通信

標準通信は、ターゲット プロセッサとのメイン インターフェイスとなるものです。 こ
れは、ターゲット デバイスへの接続とプログラミングに必要な高電圧 (VPP)、VDD 検
出ライン、クロック、データ接続を含みます。

VPP の高電圧ラインは、エミュレーション プロセッサの電圧要件に応じて 1.8 ～ 14
V の電圧を生成できます。 

VDD 検出ラインには、ターゲット プロセッサからの電流が流れます。 

クロックとデータの接続は、以下の特性を備えたインターフェイスです。

• 高インピーダンス モードのクロックおよびデータ信号 (PICkit 3 インサーキット デ
バッガ / プログラマ システムに電源が供給されていない場合を含む )

• ターゲット システムの不良または不適切な接続による過電圧からクロックおよび
データ信号を保護

• プロトタイプまたはターゲット システムの電気的短絡による過電流からクロック
とデータ信号を保護

図 A-1: 6 ピン標準ピン配置 

Note: 旧式のヘッダボードは 6 ピンの SIL コネクタではなく 6 ピンの RJ-11 コ
ネクタを使っているため、デバッガと直接接続できます。
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A.6.2 モジュラケーブルとコネクタ

標準通信では、デバッガとターゲット アプリケーションをモジュラケーブルで接続し
ます。 以下に、このケーブルとコネクタの仕様を示します。

A.6.2.1 モジュラコネクタの仕様

• メーカー名、製品番号 - AMP Incorporated、555165-1

• 販売代理店名、製品番号 - Digi-Key、A9031ND

図 A-2 の表に、アプリケーション側のモジュラコネクタの各ピンとマイクロコント
ローラのピンの対応を示します。 この構成では、ICD の機能を全て利用できます。

図 A-2: ターゲットボードのモジュラコネクタのピン配置

Modular 
Connector Pin

Microcontroller 
Pin

6 PGM (LVP)

5 RB6

4 RB7

3 Ground

2 VDD Target

1 VPP 1
6

Bottom view of Modular Connector
Pinout on Target Board

1 6

Front view of Modular Connector
on Target Board

Target Board
Transition Socket

Device-ICE

AC164110
Adapter

Header

Power

PICkit 3

Mini-USB

to PC 
cable
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ハードウェア仕様
A.6.2.2 モジュラプラグの仕様

• メーカー名、製品番号 - AMP Incorporated、5-554710-3

• 販売代理店名、製品番号 - Digi-Key、A9117ND

A.6.2.3 モジュラケーブルの仕様

• メーカー名、製品番号 - Microchip Technology 社、07-00024

A.7 ターゲットボードに関する注意事項

ターゲットボードには、選択したデバイス (1.8 ～ 5.0 V) とアプリケーションの要件
に合わせて電源を供給してください。

デバッガとターゲットの通信の方法によっては、ターゲットボードの回路に関して何
点かの注意事項があります。詳しくは以下のセクションを参照してください。

• セクション「ターゲット回路との接続」

• セクション「デバッガの正常動作を妨げる回路」
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補遺 B. PICkit 3 の回路図
ここでは、PICkit 3 インサーキット デバッガ / プログラマの回路図を示します。 デモボードの回路図は、
各ボードのユーザガイドを参照してください。

図 B-1: PICkit™ 3 の回路図 (1/2 ページ )
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図 B-2: PICkit™ 3 の回路図 (2/2 ページ )
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補遺 C. 改訂履歴
リビジョン A (2013 年 4 月 )

本書の初版
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用語集
記号、数字

[Watches] ウィンドウ (Watch Window)

ウォッチ変数の一覧が表示され、ブレークポイントで毎回表示が更新されるウィン
ドウ。

16 進数 (Hexadecimal)

0 ～ 9 の数字と A ～ F ( または a ～ f) のアルファベットを使う、16 を底とした記数
法。 A ～ F で 10 進数の 10 ～ 15 を表現する。一番右の桁が 1 の位、次の桁が 16 の
位、その次の桁が 162 = 256 の位を表す。

2 進数 (Binary)

0 と 1 の数字を使う、2 を底とした記数法。 一番右の桁が 1 の位、次の桁が 2 の位、
その次の桁が 22 = 4 の位を表す。

8 進数 (Octal)

0 ～ 7 の数字のみを使う、8 を底とした記数法。 一番右の桁が 1 の位、次の桁が 8 の
位、その次の桁が 82 = 64 の位を表す。

A

AND 条件ブレークポイント (ANDed Breakpoints)

プログラム実行を停止するために設定する AND 条件 ( ブレークポイント 1 とブレー
クポイント 2 が同時に発生した場合のみプログラム実行を停止する )。 AND 条件で実
行が停止するのは、データメモリのブレークポイントとプログラムメモリのブレーク
ポイントが同時に発生した場合のみ。

ANSI

American National Standards Institute ( 米国規格協会 ) の略。米国における標準規格
の策定と承認を行う団体。

ASCII

American Standard Code for Information Interchange の略。7 桁の 2 進数で 1 つの文
字を表現する文字セットエンコード方式。 大文字、小文字、数字、記号、制御文字等
を含む。

C
C\C++

C 言語は、簡潔な表現、現代的な制御フローとデータ構造、豊富に用意された演算子
等を特長とする汎用プログラミング言語。 C++ とは、C 言語のオブジェクト指向バー
ジョン。

COFF

Common Object File Format の略。 このフォーマットのオブジェクト ファイルは、マ
シンコードの他、デバッグ等に関する情報を含む。

CPU

「中央演算処理装置」参照。
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D
DWARF

Debug With Arbitrary Record Format の略。 ELF ファイルのデバッグ情報フォーマット。

E
EEPROM

Electrically Erasable Programmable Read Only Memory の略。 電気的に消去可能なタ
イプのPROM。 データの書き込みと消去をバイト単位で行う。 EEPROMは電源をOFF
にしても内容を保持する。

ELF

Executable and Linking Format の略。 この形式のオブジェクト ファイルはマシンコー
ドを含む。 デバッグその他の情報は DWARF で指定する。 ELF/DWARF の方が COFF
よりも最適化したコードのデバッグに適している。

EPROM

Erasable Programmable Read Only Memoryの略。 再書き込みが行えるタイプの ROM
で、消去は紫外線照射で行うものが主流。

F
FNOP

Forced No Operation の略。 Forced NOP サイクルは、2 サイクル命令の 2 サイクル目で
発生する。 PICマイクロコントローラのアーキテクチャはパイプライン構造となってお
り、現在の命令を実行中に物理アドレス空間の次の命令をプリフェッチする。 しかし、
現在の命令によってプログラム カウンタが変化した場合、プリフェッチした命令は明
示的に無視され、Forced NOP サイクルが発生する。

G
GPR

General Purpose Register ( 汎用レジスタ ) の略。 デバイスのデータメモリ (RAM) の
うち、汎用目的に使える部分。

H
Halt

プログラム実行を停止する事。 Halt を実行する事は、ブレークポイントで停止する事
と同じ。

HEX コード /HEX ファイル (Hex Code/Hex File)

HEX コードは、実行可能な命令を 16 進数形式のコードで保存したもの。 HEX ファイ
ルは、HEX コードを格納したファイル。

I
ICE/ICD

インサーキット エミュレータ / インサーキット デバッガの略。 ターゲットデバイスの
デバッグとプログラミングを行うためのハードウェア ツール。 エミュレータは、デ
バッガよりも多くの機能 ( トレース等 ) を備える。

インサーキット エミュレーション /インサーキット デバッグとは、 インサーキット エ
ミュレータまたはデバッガを使った作業の事を指す。

-ICE/-ICD: インサーキット エミュレーション / デバッグ用の回路を内蔵したデバイス
(MCU または DSC)。 このデバイスは必ずヘッダボードにマウントし、インサーキット
エミュレータまたはデバッガによるデバッグ用に使う。
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ICSP

In-Circuit Serial Programming ( インサーキット シリアル プログラミング ) の略。
Microchip 社製の組み込みデバイスをシリアル通信を利用して最小限のデバイスピン
でプログラミングする方法。

IDE

Integrated Development Environment の略。MPLAB IDE/MPLAB X IDE の IDE と同じ
意味。

IEEE

Institute of Electrical and Electronics Engineers の略。

L
LVDS

Low Voltage Differential Signaling の略。 銅線を使って、低ノイズ、低消費電力、低振
幅でデータを高速伝送 (Gbps) する方法。 

標準の I/O シグナリングでは、データストレージは実際の電圧レベルに依存する。 電
圧レベルは信号線の長さによって影響を受ける ( 信号線が長いと抵抗が増大し、電圧
が低下する )。 これに対し LVDS では、データストレージは実際の電圧レベルでなく
正と負の電圧値によってのみ区別する。 従って、長い信号線でもクリアで安定した
データストリームを維持した伝送が可能。

出典 : http://www.webopedia.com/TERM/L/LVDS.html

M
Make Project

アプリケーションを再ビルドするコマンド。前回の完全なコンパイル後に変更された
ソースファイルのみを再コンパイルする。

make ファイル (Makefile)

プロジェクトの Make に関する指示をファイルにエクスポートしたもの。 このファイル
は、MPLAB IDE/MPLAB X IDE 以外の環境で makeコマンドを実行してプロジェクトを
ビルドする際に使う。

MCU

Microcontroller Unit の略。 マイクロコントローラの事。 「µC」と表記する事もある。

MPASM™ アセンブラ (MPASM Assembler)

PIC マイクロコントローラ、KeeLoq®、Microchip 社のメモリデバイスに対応した
Microchip 社の再配置可能なマクロアセンブラ。

MPLAB ( 言語ツール名 ) for ( デバイス名 ) (MPLAB Language Tool for Device)

特定のデバイスに対応した Microchip 社の C コンパイラ、アセンブラ、リンカ。 言語
ツールは、アプリケーションで使うデバイスに対応したものを選択する必要がある。
例えば PIC18 MCU 用の C コードを作成する場合は「MPLAB C Compiler for PIC18
MCU」を使う。

MPLAB ICD

MPLAB IDE/MPLAB X IDE と連携する Microchip 社のインサーキット デバッガ。
「ICE/ICD」参照。

MPLAB IDE/MPLAB X IDE

Microchip 社の統合開発環境。 エディタ、プロジェクト マネージャ、シミュレータが
付属する。
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MPLAB PM3

Microchip 社のデバイス プログラマ。 PIC18 マイクロコントローラと dsPIC デジタル
シグナル コントローラの書き込みに対応。 MPLAB IDE/MPLAB X IDE との併用も、単
体での使用も可能。 PRO MATE II の後継製品。

MPLAB REAL ICE インサーキット エミュレータ (MPLAB REAL ICE In-Circuit
Emulator)

MPLAB IDE/MPLAB X IDE と組み合わせて使う Microchip 社の次世代インサーキット
エミュレータ。 「ICE/ICD」参照。

MPLAB SIM

MPLAB IDE/MPLAB X IDE と組み合わせて使う Microchip 社のシミュレータで、PIC
MCU と dsPIC DSC に対応する。

MPLAB Starter Kit for ( デバイス名 ) (MPLAB Starter Kit for Device)

特定のデバイスでの作業を開始する上で必要となるものを全てセットにした
Microchip 社のスタータキット。 既製のアプリケーションの動作を確認した後で、一
部を変更してカスタム アプリケーションとしてデバッグとプログラムを行う。

MPLIB™ オブジェクト ライブラリアン (MPLIB Object Librarian)

MPLAB IDE/MPLAB X IDEと組み合わせて使うMicrochip社のライブラリアン。 MPLIB
ライブラリアンは、MPASMアセンブラ(mpasmまたはmpasmwin v2.0)またはMPLAB
C18 C コンパイラで作成した COFF オブジェクト モジュールに使うオブジェクト ラ
イブラリアン。

MPLINK™ オブジェクト リンカ (MPLINK Object Linker)

Microchip 社の MPASM アセンブラと C18 C コンパイラに対応したオブジェクト リ
ンカ。 Microchip 社の MPLIB ライブラリアンとの併用も可能。 MPLAB IDE/MPLAB X
IDE との併用を前提に設計されているが、必須ではない。

MRU

Most Recently Used の略。 最近使ったファイルとウィンドウの事。MPLAB IDE/MPLAB
X IDE のメインメニューで選択できる。

N
NOP

No Operationの略。 実行してもプログラム カウンタが進むだけで何も動作を行わない
命令。

O
OTP

One Time Programmable の略。 パッケージに窓のない EPROM デバイス。 EPROM を
消去するには紫外線照射が必要なため、パッケージに窓のあるデバイスしか消去でき
ない。

P
PC

パーソナル コンピュータまたはプログラム カウンタの略。

PIC MCU (PIC MCUs)

Microchip 社の全てのマイクロコントローラ ファミリの総称。

PICkit 2/3

Microchip 社の開発用デバイス プログラマで、Debug Express によるデバッグ機能を
備える。 サポートしているデバイスの種類は、各ツールの Readme ファイル参照。
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Psect

GCC のセクションに相当する OCG の用語。プログラム セクション (program section)
の略語。 リンカが 1 つのまとまりとして処理するコードまたはデータのブロック。

PWM 信号 (PWM Signals)

パルス幅変調 (Pulse Width Modulation) 信号。 一部の PIC MCU は周辺モジュールとし
て PWM を内蔵している。

R
RAM

Random Access Memory の略。データメモリ。 任意の順にメモリ内の情報にアクセス
できる。

ROM

Read Only Memory の略。プログラムメモリ。 メモリの内容を変更できない。

Run

エミュレータを Halt から解放するコマンド。エミュレータはアプリケーション コー
ドを実行し、I/O に対してリアルタイムに変更、応答を行う。

S
Serialized Quick Turn Programming (SQTP)

デバイス プログラマでマイクロコントローラをプログラムする際に、各デバイスに異
なるシリアル番号を書き込めるようにする機能。 エントリコード、パスワード、ID 番
号等を書き込む目的で使う。

SQTP

「Serialized Quick Turn Programming」参照。

Step Into

Single Step と同じコマンド。 Step Over とは異なり、Step Into では CALL 命令が呼び
出すサブルーチン内もステップ実行する。

Step Over

Step Over を実行すると、サブルーチン内をステップ実行せずにコードをデバッグで
きる。 Step Over では、CALL命令があると CALLの次の命令にブレークポイントが設
定される。 何らかの理由により、サブルーチンが無限ループになる等、正しくリター
ンしない場合、次のブレークポイントには到達しない。 CALL命令の処理以外は、Step
Over コマンドと Single Step コマンドは同じ。

Step Out

現在ステップ実行中のサブルーチンから抜け出すためのコマンド。 このコマンドを実
行すると、サブルーチンの残りのコードを全て実行し、サブルーチンのリターンアド
レスで実行が停止する。

U
USB

Universal Serial Bus の略。2 本のシリアル伝送線で PC と外部周辺機器の通信を行う
外部周辺インターフェイス規格。 USB 1.0/1.1 でサポートされるデータ転送レートは
12 Mbps。 USB 2.0 ( ハイスピード USB) は最大 480 Mbps のデータレートをサポート
している。
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V
Volatile

メモリ内の変数へのアクセス方法に影響を与えるコンパイラの最適化を抑制する変
数修飾子。

あ

アーカイブ / アーカイバ (Archive/Archiver)

アーカイブ / ライブラリは、再配置可能なオブジェクト モジュールの集まり。 複数の
ソースファイルをオブジェクト ファイルにアセンブルした後、アーカイバ / ライブラ
リアンを使ってこれらオブジェクト ファイルを 1 つのアーカイブ / ライブラリ ファ
イルにまとめると生成される。 アーカイブ / ライブラリをオブジェクト モジュールや
他のアーカイブ / ライブラリとリンクすると、実行コードが生成される。

アクセス エントリポイント (Access Entry Points)

リンク時に定義されていない可能性のある関数に、セグメントの境界を越えて制御を
渡すための手段。 ブートセグメントとセキュア アプリケーション セグメントを別々
にリンクする方法を提供する。

アクセスメモリ (Access Memory)

PIC18 のみ - PIC18 でバンクセレクト レジスタ (BSR) の設定に関わらずアクセスで
きる特殊なレジスタ。

アセンブリ / アセンブラ (Assembly/Assembler)

アセンブリとは、2 進数のマシンコードをシンボル表現で記述したプログラミング言
語。 アセンブラとは、アセンブリ言語のソースコードをマシンコードに変換する言語
ツール。

アップロード (Upload)

エミュレータやプログラマ等のツールからホスト PC へ、またはターゲットボードか
らエミュレータへデータを転送する事。

アドレス (Address)

メモリ内の位置を一意に特定する値。

アプリケーション (Application)

PIC® マイクロコントローラで制御されるソフトウェアとハードウェアを組み合わせ
たもの。

アルファベット文字 (Alphabetic Character)

アルファベットの小文字と大文字の総称 (a, b, •••, z, A, B,•••, Z)。

イベント (Event)

アドレス、データ、パスカウント、外部入力、サイクルタイプ ( フェッチ、R/W)、タ
イムスタンプ等、バスサイクルを記述したもの。 トリガ、ブレークポイント、割り込
みを記述するために使う。

入れ子の深さ (Nesting Depth)

マクロに他のマクロを含める事のできる階層の数。

インポート (Import)

Hex ファイル等の外部ソースから MPLAB IDE/MPLAB X IDE にデータを取り込む事。

ウォッチドッグ タイマ (WDT)

PIC マイクロコントローラに内蔵されたタイマの 1 つで、ユーザが設定した期間が経
過するとプロセッサをリセットする。 WDT の有効化 / 無効化、設定はコンフィグレー
ション ビットで行う。

ウォッチ変数 (Watch Variable)

デバッグ セッション中に [Watches] ウィンドウで観察できる変数。
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英数字 (Alphanumeric)

アルファベット文字と 0 ～ 9 の 10 進数の数字の総称 (0,1,•••,9)。

永続データ (Persistent Data)

クリアも初期化もされないデータ。 デバイスをリセットしてもアプリケーションが
データを保持できるようにするために使う。

エクスポート (Export)

MPLAB IDE/MPLAB X IDE のデータを標準フォーマットで外部に出力する事。

エピローグ (Epilogue)

コンパイラで生成したコードのうち、スタック領域の割り当て解除、レジスタの復帰、
ランタイムモデルで指定したその他のマシン固有の要件を実行するコード部分。 関数
のユーザコードの後、関数リターンの直前にエピローグを実行する。

エミュレーション / エミュレータ (Emulation/Emulator)

「ICE/ICD」参照。

エラー / エラーファイル (Error/Error File)

プログラムの処理を継続できない問題が発生するとエラーとして報告される。 可能な
場合、エラーは問題が発生したソースファイル名と行番号を特定する。 エラーファイ
ルは、言語ツールから出力されたエラーメッセージと診断結果を格納する。

演算子 (Operators)

定義可能な式を構成する際に使う「+」や「-」等の記号。 各演算子に割り当てられた
優先順位に基づいて式を評価する。

エンディアン (Endianness)

マルチバイト オブジェクトにおけるバイトの並び順。

オブジェクト コード / オブジェクト ファイル (Object Code/Object File)

オブジェクト コードとは、アセンブラまたはコンパイラが生成するマシンコードの事。
オブジェクト ファイルとは、マシンコードを格納したファイル。デバッグ情報を含む
事もある。 そのまま実行できるものと、他のオブジェクト ファイル ( 例 : ライブラリ )
とリンクしてから完全な実行プログラムを生成する再配置可能形式のものがある。

オブジェクト ファイル ディレクティブ (Object File Directives)

オブジェクト ファイル作成時にのみ使うディレクティブ。

オフチップメモリ (Off-Chip Memory)

PIC18 で選択できるメモリオプション。ターゲットボード上のメモリを使うか、また
は全てのプログラムメモリをエミュレータから供給する。 [Options]>[Development
Mode] の順にクリックして [Memory] タブでオフチップメモリの選択を行う。

オペコード (Opcodes)

Operational Code の略。 「ニーモニック」参照。

か

外部 RAM (External RAM)

オフチップの読み書き可能なメモリ。

外部シンボル (External Symbol)

外部リンケージを持つ識別子のシンボル。 参照の場合と定義の場合がある。

外部シンボル解決 (External Symbol Resolution)

リンカが全ての入力モジュールの外部シンボル定義を 1 つにまとめ、全ての外部シン
ボル参照を解決しようとするプロセス。 外部シンボル参照に対応する定義が存在しな
い場合、リンカエラーとなる。
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外部入力ライン (External Input Line)

外部信号に基づいてイベントを設定するための外部入力信号ロジックプローブ ライ
ン (TRIGIN)。

外部ラベル (External Label)

外部リンケージを持つラベル。

外部リンケージ (External Linkage)

関数または変数が、それ自身を定義したモジュールの外部から参照できる場合、外部
リンケージを持つという。

拡張マイクロコントローラ モード (Extended Microcontroller Mode)

拡張マイクロコントローラ モードでは、内蔵プログラムメモリと外部メモリの両方が
利用できる。 プログラムメモリのアドレスが PIC18 の内部メモリ空間より大きい場
合、自動的に外部メモリの実行に切り換わる。

拡張モード (Extended Mode) (PIC18 MCU)

コンパイラの動作モードの 1 つ。拡張命令 (ADDFSR、ADDULNK、CALLW、MOVSF、
MOVSS、PUSHL、SUBFSR、SUBULNK) とリテラル オフセットによるインデックス ア
ドレス指定を利用できる。

環境 (Environment)

MPLAB PM3 - デバイスのプログラミングに関する設定ファイルを保存したフォルダ。
このフォルダを SD/MMC カードに転送できる。

クリーン (Clean)

クリーンする事により、アクティブなプロジェクトのオブジェクト ファイル、Hex
ファイル、デバッグファイル等、全ての中間ファイルが削除される。 これらのファイル
は、プロジェクトのビルド時に他のファイルから再構築される。

緩和 (Relaxation)

ある命令を、機能が同じでよりサイズの小さい命令に変換する事。 コードサイズを抑
えるために便利である。 最新の MPLAB ASM30 には、CALL 命令を RCALL 命令に緩
和する機能がある。 現在の命令から +/- 32k 命令ワード以内にあるシンボルを呼び出
す場合にこの変換を行う。

記憶域クラス (Storage Class)

指定されたオブジェクトを格納する記憶場所の持続期間を決定する。 

記憶域修飾子 (Storage Qualifier)

宣言されるオブジェクトの特別な属性を示す ( 例 : const)。

基数 (Radix)

アドレスを指定する際の記数法 (16 進法、10 進法 ) の底。

警告 (Warning)

MPLAB IDE/MPLAB X IDE - デバイス、ソフトウェア ファイル、装置に物理的な損傷
を与える可能性のある状況で、ユーザに注意を促すために表示されるメッセージ。

16 ビットアセンブラ / コンパイラ - 問題となる可能性のある状態を警告として報告す
るが、処理は停止されない。 MPLAB C30 の警告メッセージはソースファイル名と行
番号を報告するが、エラーメッセージと区別するために「warning:」の文字列も付
加する。 

高級言語 (High Level Language)

プログラムを記述するための言語で、プロセッサから見てアセンブリよりも遠い位置
関係にあるもの。

校正メモリ (Calibration Memory)

PIC マイクロコントローラの内蔵 RC オシレータやその他の周辺モジュールの校正値
を格納するための特殊機能レジスタまたはレジスタ。
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国際標準化機構 (International Organization for Standardization)

コンピューティングや通信をはじめ、多くのテクノロジとビジネス関連の標準規格の
策定を行っている団体。 一般的に ISO と呼ぶ。

コマンドライン インターフェイス (Command Line Interface)

プログラムとユーザのやり取りをテキストの入出力だけで行う方法。

コンパイラ (Compiler)

高級言語で記述されたソースファイルをマシンコードに変換するプログラム。

コンパイルド スタック (Compiled Stack)

コンパイラが管理するメモリの領域で、この領域内で変数に静的に空間を割り当てる。
ターゲット デバイス上にソフトウェア スタックまたはハードウェア スタックのメカニ
ズムを効率的に実装できない場合、コンパイルド スタックがソフトウェア スタック
またはハードウェア スタックに置き換わる。

コンフィグレーション ビット (Configuration Bits)

PIC MCU と dsPIC DSC の動作モードを設定するために書き込む専用ビット。 コン
フィグレーション ビットは事前プログラミングされている場合とされていない場合
がある。

さ

再帰 (Recursion)

定義した関数またはマクロがそれ自身を呼び出す事。 再帰マクロを作成する際は、再
帰から抜けずに無限ループとなりやすいため注意が必要。

再帰呼び出し (Recursive Calls)

直接または間接的に自分自身を呼び出す関数。

再入可能 (Reentrant)

1 つの関数を複数呼び出して同時に実行できる事。 直接または間接再帰、あるいは割
り込み処理中の実行によって起こる事がある。

再配置 (Relocation)

リンカが絶対アドレスを再配置可能セクションに割り当てる事。再配置可能セクショ
ン内の全てのシンボルを新しいアドレスに更新する。

再配置可能 (Relocatable)

アドレスがメモリの固定番地に割り当てられていないオブジェクト。

再配置可能セクション (Relocatable Section)

16ビットアセンブラ - アドレスが固定されていない (絶対アドレスでない )セクション。
再配置可能セクションには、再配置と呼ばれるプロセスによって、リンカがアドレス
を割り当てる。

左辺値 (L-value)

検査または変更が可能なオブジェクトを指し示す式。 左辺値は代入演算子の左側で使う。

シーケンス ブレークポイント (Sequenced Breakpoints)

シーケンスで発生するブレークポイント。 ブレークポイントのシーケンスはボトム
アップ方式で実行される。つまり、シーケンスの最後のブレークポイントが最初に発
生する。

シェル (Shell)

MPASM アセンブラにおいて、マクロアセンブラへの入力を行うためのプロンプト イ
ンターフェイス。 MPASM アセンブラには DOS 用シェルと Windows 用シェルの 2 種
類がある。

式 (Expressions)

算術演算子または論理演算子で区切った定数または記号の組み合わせ。
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識別子 (Identifier)

関数または変数の名前。

システム ウィンドウ コントロール (System Window Control)

ウィンドウと一部のダイアログの左上隅にあるコントロール。 通常、このコントロール
をクリックすると、[ 最小化 ]、[ 最大化 ]、[ 閉じる ] 等のメニュー項目がポップアップ
表示される。

実行可能コード (Executable Code)

読み込んで実行できる形式のソフトウェア。

シナリオ (Scenario)

MPLAB SIM シミュレータにおいて、スティミュラス制御を具体的に設定したもの。

シミュレータ (Simulator)

デバイスの動作をモデリングするソフトウェア プログラム。

修飾子 (Qualifier)

パスカウンタで使ったり、複合トリガにおける次の動作前のイベントとして使ったり
するアドレスまたはアドレス範囲。

条件付きアセンブリ (Conditional Assembly)

アセンブリ言語で、ある特定の式のアセンブル時の値に基づいて含まれたり除外され
たりするコード。

条件付きコンパイル (Conditional Compilation)

プログラムの一部を、プリプロセッサ ディレクティブで指定した特定の定数式が真の
場合のみコンパイルする事。

初期化済みデータ (Initialized Data)

初期値を指定して定義されたデータ。 C では、

int myVar=5;

として定義した変数は初期化済みデータセクションに格納する。

シングルステップ (Single Step)

コードを 1命令ずつ実行するコマンド。 1命令を実行するたびに、MPLAB IDE/MPLAB
X IDE のレジスタ ウィンドウ、ウォッチ変数、ステータス ディスプレイの表示が更
新されるため、命令実行を解析してデバッグできる。 C コンパイラのソースコードも
シングルステップ実行できるが、その場合は 1 命令ずつ実行されるのではなく、高級
言語のCで記述されたコードの1行から生成される全てのアセンブリレベル命令がシ
ングルステップで実行される。

シンボル (Symbol)

プログラムを構成する各種の要素を記述する汎用のメカニズム。 関数名、変数名、セ
クション名、ファイル名、struct/enum/union タグ名等がある。MPLAB IDE/MPLAB X
IDE では、主に変数名、関数名、アセンブリラベルをシンボルと呼ぶ。 リンク実行後
は、シンボルの値はメモリ内の値となる。

推奨しない機能 (Deprecated Features)

後方互換性確保のためにサポートしているだけで現在は使っておらず、いずれ廃止に
なる事が決まっている機能。

スキッド (Skid)

ハードウェア ブレークポイントを使ってプロセッサを停止する場合、ブレークポイント
からさらに 1 つ以上の命令を実行してプロセッサが停止する事がある。 ブレークポイ
ントの後に実行する命令の数をスキッドと呼ぶ。
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スキュー (Skew)

命令実行に対応する情報は、異なる複数のタイミングでプロセッサバスに現れる。 例
えば、実行されるオペコードは直前の命令の実行時にフェッチとしてバスに現れる。
ソースデータのアドレスと値、並びにデスティネーション データのアドレスは、オペ
コードが実際に実行される時にバスに現れる。デスティネーション データの値は次の
命令の実行時にバスに現れる。 トレースバッファは、1 インスタンスでバス上に存在
する情報をキャプチャする。 従って、トレースバッファの 1 エントリには 3 つの命令
の実行情報が含まれる。 1 つの命令実行で、ある情報から次の情報までにキャプチャ
されるサイクル数をスキューと呼ぶ。

スタック、コンパイルド (Stack, Compiled)

コンパイラが管理し割り当てるメモリの領域で、この領域内で変数に静的に空間を割
り当てる。 ターゲット デバイス上にソフトウェア スタックのメカニズムを効率的に
実装できない場合、ソフトウェア スタックがコンパイルド スタックに置き換わる。 この
メカニズムでは、関数は再入可能ではなくなる。

スタック、ソフトウェア (Stack, Software)

アプリケーションがリターンアドレス、関数パラメータ、ローカル変数を保存するの
に使うメモリ。 このメモリはプログラムでの命令の実行時に動的に割り当てられる。
これによって、再入可能な関数の呼び出しが可能になる。

スタック、ハードウェア (Stack, Hardware)

PIC マイクロコントローラで関数を呼び出す時にリターンアドレスを格納する場所。

スタティック RAM (SRAM) (Static RAM、SRAM)

Static Random Access Memory の略。 ターゲットボード上の読み書き可能なプログラ
ムメモリ。頻繁に書き換える必要のないプログラムを書き込む。

スティミュラス (Stimulus)

シミュレータへの入力。すなわち、外部信号に対する応答をシミュレートするために
生成されるデータ。 通常、テキストファイルにアクションのリストとしてこのデータ
を記述する。 スティミュラスの種類には、非同期、同期 ( ピン )、クロック動作、レジ
スタがある。

ステータスバー (Status Bar)

MPLAB IDE/MPLAB X IDE ウィンドウの一番下にあるバーで、カーソル位置、開発
モードとデバイス、アクティブなツールバー等に関する情報が表示される。

ストップウォッチ (Stopwatch)

実行サイクルを測定するためのカウンタ。

制御ディレクティブ (Control Directives)

アセンブリ言語コード内で使うディレクティブで、指定した式のアセンブル時の値に
基づいてコードを含めるか除外するかを決定する。

セクション (Section)

OCG の psect に相当する GCC の用語。 リンカが 1 つのまとまりとして処理するコード
またはデータのブロック。

セクション属性 (Section Attribute)

GCC のセクションの特徴を表す情報 ( 例 : accessセクション )。

絶対シンボル (Symbol, Absolute)

アセンブリの .equディレクティブによる定義等、即値を表す。

絶対セクション (Absolute Section)

リンカで変更されない固定 ( 絶対 ) アドレスを持つ GCC コンパイラのセクション。
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絶対変数 / 関数 (Absolute Variable/Function)

OCG コンパイラの @ address 構文を使って絶対アドレスに配置される変数または
関数。

相互参照ファイル (Cross Reference File)

シンボルテーブルとそのシンボルを参照するファイルリストを参照するファイル。 シ
ンボルが定義されている場合、リストの最初のファイルがシンボル定義の位置となる。
残りのファイルはシンボルへの参照を含む。

ソースコード (Source Code)

プログラマ ( 人間 ) が記述したコンピュータ プログラム。 プログラミング言語で記述
されたソースコードは、マシンコードに変換して実行するか、またはインタプリタで
実行される。

ソースファイル (Source File)

ソースコードを記述した ASCII テキストファイル。

属性 (Attribute)

GCC の C プログラムの変数または関数の特徴を表す情報で、マシン固有の特性を記
述する目的で使う。

属性 ( セクション属性 ) (Attribute、Section)

「executable」、「readonly」、「data」等、GCC のセクションの特徴を表す情報。アセ
ンブラの .sectionディレクティブでフラグとして指定できる。

た

ターゲット アプリケーション (Target Application)

ターゲットボードに読み込んだソフトウェア。

ターゲット プロセッサ (Target Processor)

ターゲット アプリケーション ボードで使われているマイクロコントローラ デバイス。

ターゲット (Target)

ユーザ ハードウェアの事。

ターゲットボード (Target Board)

ターゲット アプリケーションを構成する回路とプログラマブルなデバイス。

ダウンロード (Download)

ホストから別のデバイス ( エミュレータ、プログラマ、ターゲットボード等 ) にデータ
を送信する事。

致命的エラー (Fatal Error)

コンパイルがただちに停止するようなエラー。 エラー以降はメッセージも出力されない。

中央演算処理装置 (Central Processing Unit)

デバイス内で、実行する正しい命令をフェッチし、デコードして実行する装置。 必要
に応じて、算術論理演算装置 (ALU) と組み合わせて命令実行を完了する。 プログラム
メモリのアドレスバス、データメモリのアドレスバス、スタックへのアクセスを制御
する。

ツールバー (Tool Bar)

MPLAB IDE/MPLAB X IDE の機能を実行するためのボタン ( アイコン ) を縦または横
に並べたもの。

ディレクティブ (Directives)

言語ツールの動作を制御するためにソースコードに記述するステートメント。
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データ ディレクティブ (Data Directives)

アセンブラが行うプログラムメモリまたはデータメモリの割り当てを制御するディ
レクティブ。データ項目をシンボル ( 意味のある名前 ) で参照する手段として使う。

データメモリ (Data Memory)

Microchip 社の MCU と DSC では、データメモリ (RAM) は汎用レジスタ (GPR) と特
殊機能レジスタ (SFR) から成る。 EEPROM データメモリを内蔵したデバイスもある。

データ監視および制御インターフェイス (DMCI)

MPLAB X IDE 内のツール。 このインターフェイスは、プロジェクト内のアプリケーショ
ン変数の動的な入力制御を提供する。 4 つの動的に割り当て可能なグラフィック ウィ
ンドウを使って、アプリケーションが生成するデータをグラフィカルに表示できる。

デジタルシグナル コントローラ (Digital Signal Controller)

デジタル信号処理機能をサポートしたマイクロコントローラ。Microchip 社の dsPIC
DSC 等。

デジタル信号処理 / デジタルシグナル プロセッサ (Digital Signal Processing/Digital
Signal Processor)

デジタル信号処理 (DSP) とは、デジタル信号をコンピュータで処理する事。通常は、
アナログ信号 ( 音声または画像 ) をデジタル形式に変換 ( サンプリング ) して処理す
る事をいう。 デジタルシグナル プロセッサとは、信号処理用に設計されたマイクロプ
ロセッサの事。

デバイス プログラマ (Device Programmer)

マイクロコントローラ等、電気的に書き込み可能な半導体デバイスをプログラミング
するためのツール。

デバッグ / デバッガ (Debug/Debugger)

「ICE/ICD」参照。

デバッグ情報 (Debugging Information)

コンパイラとアセンブラでこのオプションを選択すると、アプリケーション コードの
デバッグに使える各種レベルの情報を出力できる。 デバッグ オプションの選択の詳
細はコンパイラまたはアセンブラのマニュアル参照。

テンプレート (Template)

後でファイルに挿入するために作成するテキスト行。 MPLAB エディタでは、テンプ
レートはテンプレート ファイルに保存される。

特殊機能レジスタ (Special Function Registers: SFR)

I/O プロセッサ機能、I/O ステータス、タイマ等の各種モードや周辺モジュールを制御
するレジスタ専用に使うデータメモリ (RAM) 領域。

匿名構造体 (Anonymous Structure)

16 ビット C コンパイラ  - 無名の構造体

PIC18 C コンパイラ - C 共用体のメンバーである名前のない構造体。 匿名構造体のメ
ンバーは、その構造体を包含している共用体のメンバーと同じようにアクセスでき
る。 例えば以下のサンプルコードでは、hiと loは共用体 casterに含まれる匿名構
造体のメンバーである。

union castaway {
 int intval;
 struct {
  char lo; //accessible as caster.lo
  char hi; //accessible as caster.hi
 };
} caster;
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トライグラフ (Trigraphs)

「??」で始まる3文字のシーケンス。ISO Cで定義されており、1つの文字に置換される。

トリガ出力 (Trigger Output)

任意のアドレスまたはアドレス範囲で生成でき、トレースとブレークポイントの設定か
ら独立したエミュレータ出力信号の事。 トリガ出力ポイントはいくつでも設定できる。

トレース (Trace)

プログラム実行のログを記録するエミュレータまたはシミュレータの機能。 エミュ
レータはプログラム実行のログをトレースバッファに記録し、これを MPLAB
IDE/MPLAB X IDE のトレース ウィンドウにアップロードする。

トレースマクロ (Trace Macro)

エミュレータ データからのトレース情報を提供するマクロ。 これはソフトウェア ト
レースのため、トレースを利用するには、マクロをコードに追加し、コードを再コン
パイルまたは再アセンブルし、ターゲット デバイスにこのコードをプログラムする必
要がある。

レースメモリ (Trace Memory)

エミュレータに内蔵されたトレース用のメモリ。 トレースバッファとも呼ばれる。

な

内部リンケージ (Internal Linkage)

関数または変数が、それ自身を定義したモジュールの外部からアクセスできない場
合、内部リンケージを持つという。

生データ (Raw Data)

あるセクションに関連付けられたコードまたはデータを 2 進数で表現したもの。

ニーモニック (Mnemonics)

マシンコードと 1 対 1 で対応したテキスト命令。 オペコードとも呼ぶ。

ネイティブ データサイズ (Native Data Size)

ネイティブ トレースの場合、[Watches] ウィンドウで使う変数のサイズは選択したデ
バイスのデータメモリと同じサイズ (PIC18 の場合は同じバイトサイズ、16 ビットデ
バイスの場合は同じワードサイズ ) である必要がある。

ノード (Node)

MPLAB IDE/MPLAB X IDE のプロジェクトを構成するコンポーネント。

は

パスカウンタ (Pass Counter)

イベント ( 特定のアドレスの命令を実行する等 ) が発生するたびに値をデクリメント
するカウンタ。 パスカウンタの値がゼロになると、イベントの条件を満たす。 パスカ
ウンタはブレークロジック、トレースロジック、複合トリガダイアログの任意のシー
ケンシャル イベントに割り当てられる。

パワーオン リセット エミュレーション (Power-on-Reset Emulation)

データ RAM 空間に無作為な値を書き込んで、初回電源投入時の RAM の非初期化値
をシミュレートするソフトウェア無作為化処理。

ヒープ (Heap)

動的メモリ割り当てに使うメモリ空間。メモリブロックの割り当てと解放は実行時に
任意の順序で行う。

非拡張モード (Non-Extended Mode) (PIC18 MCU)

コンパイラの動作モードの 1 つ。拡張命令もリテラル オフセットによるインデック
ス アドレス指定も利用しない。
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非初期化データ (Uninitialized Data)

初期値なしで定義されたデータ。 C では、

int myVar; 

は、非初期化済みデータセクションに格納される変数を定義する。

非同期 (Asynchronously)

複数のイベントが同時には発生しない事。 一般に、プロセッサ実行中の任意の時点で
発生する割り込みに言及する際に使う。

非同期スティミュラス (Asynchronous Stimulus) 

シミュレータ デバイスへの外部入力をシミュレートするために生成されるデータ。

非リアルタイム (Non Real Time)

ブレークポイントで停止中、またはシングルステップ実行中のプロセッサ、あるいは
シミュレータ モードで動作中の MPLAB IDE/MPLAB X IDE を指す。

ビルド (Build)

全てのソースファイルのコンパイルとリンクを行ってアプリケーションを作成する事。

ファイルレジスタ (File Registers)

汎用レジスタ (GPR) と特殊機能レジスタ (SFR) から成る内蔵のデータメモリ。

ファントムバイト (Phantom Byte)

dsPIC アーキテクチャで、24 ビット命令ワードを 32 ビット命令ワードと見なして扱
う場合に使う未実装バイト。 dsPIC の hex ファイルに見られる。

フィックスアップ (Fixup)

リンカによる再配置後にオブジェクト ファイルのシンボル参照を絶対アドレスに置
き換える処理。

フィルタ (Filter)

トレース ディスプレイまたはデータファイルにどのデータを含めるか /除外するかを
選択するもの。

ブックマーク (Bookmark)

ファイル内の特定の行に簡単な操作でアクセスできるようにする機能。

[Editor] ツールバーの [Toggle Bookmarks] を選択してブックマークを追加または削除
する。 このツールバーの他のアイコンをクリックすると、次または前のブックマーク
に移動する。

プラグイン (Plug-ins)

MPLAB IDE/MPLAB X IDE では、標準コンポーネントにプラグイン モジュールを追
加する事で、各種ソフトウェア / ハードウェア ツールに対応する。 一部のプラグイン
ツールは、[Tools] メニューから利用できる。

プラグマ (Pragma)

特定のコンパイラにとって意味を持つディレクティブ。 一般に、実装で定義した情報
をコンパイラに伝達するために使う。 MPLAB C30 は属性を利用してこの情報を伝達
する。

フラッシュ (Flash)

データの書き込みと消去をバイト単位ではなくブロック単位で行えるタイプの
EEPROM。

不揮発性ストレージ (Non-Volatile Storage)

電源を OFF にしても内容が失われないストレージ デバイス。
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フリースタンディング (Free-Standing)

複素数型を使っておらず、ライブラリ (ANSI C89 規格第 7 節 ) で規定する機能の使用が
標準ヘッダ (<float.h>、<iso646.h>、<limits.h>、<stdarg.h>、<stdbool.h>、
<stddef.h>、<stdint.h>) の内容のみに限定されている厳密な規格合致プログラ
ムを受理する処理系。

ブレークポイント (Breakpoint)

ハードウェア ブレークポイント : 実行するとファームウェアの実行が停止するイベント。

ソフトウェア ブレークポイント : ファームウェアの実行が停止するアドレス。 通常、特別
な Break 命令で実行が停止される。

フレームポインタ (Frame Pointer)

スタックベースの引数とスタックベースのローカル変数の境界となるスタック番地
を指し示すポインタ。 ここを基準にすると、現在の関数のローカル変数やその他の値
に容易にアクセスできる。

プログラム カウンタ ユニット (Program Counter Unit)

16 ビットアセンブラ - プログラムメモリのレイアウトを概念的に表現したもの。 プロ
グラム カウンタは 1 命令ワードで 2 つインクリメントする。 実行可能セクションで
は、2 プログラム カウンタ ユニットは 3 バイトに相当する。 読み出し専用セクション
では、2 プログラム カウンタ ユニットは 2 バイトに相当する。

プログラム カウンタ (Program Counter)

現在実行中の命令のアドレスを格納した場所。

プログラムメモリ (Program Memory)

MPLAB IDE/MPLAB X IDE - デバイス内で命令を保存するメモリ空間。 また、エミュ
レータまたはシミュレータにダウンロードしたターゲット アプリケーションの
ファームウェアを格納するメモリ空間もプログラムメモリと呼ぶ。

16 ビットアセンブラ / コンパイラ - デバイス内で命令を保存するメモリ空間。

プロジェクト (Project)

アプリケーションのビルドに必要なファイル (ソースコードやリンカスクリプト ファ
イル等 ) 一式と、各種ビルドツールやビルドオプションとの関連付けをまとめたもの。

プロトタイプ システム (Prototype System)

ユーザのターゲット アプリケーションまたはターゲットボードの事。

プロファイル (Profile)

MPLAB SIM シミュレータにおいて、実行したスティミュラスをレジスタ別に一覧表
示したもの。

プロローグ (Prologue)

コンパイラで生成したコードのうち、スタック領域の割り当て、レジスタの退避、ラ
ンタイムモデルで指定したその他のマシン固有の要件を実行するコード部分。 プロ
ローグは、関数のユーザコードの前に実行する。

ベクタ (Vector)

リセットまたは割り込みが発生した時にアプリケーションのジャンプ先となるメモ
リ番地。

ホスト PC (PC Host)

サポートされた Windows オペレーティング システムが動作する PC。

ポッド (Pod)

インサーキット エミュレータまたはデバッガの筐体。 丸型の場合「パック」(Puck) と
呼ぶ事もある。あるいは「プローブ」(Probe) とも呼ぶが、「論理プローブ」と混同せ
ぬよう注意が必要。
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ま

マイクロコントローラ モード (Microcontroller Mode)

PIC18 マイクロコントローラで設定可能なプログラムメモリ構成の 1 つ。 マイクロコ
ントローラ モードでは、内部実行のみを許可する。 つまり、マイクロコントローラ
モードでは内蔵プログラムメモリしか利用できない。

マイクロコントローラ (Microcontroller)

CPU、RAM、プログラムメモリ、I/O ポート、タイマ等、多くの機能を統合したチップ。

マイクロプロセッサ モード (Microprocessor Mode)

PIC18 マイクロコントローラで設定可能なプログラムメモリ構成の 1 つ。 マイクロプ
ロセッサ モードでは、内蔵プログラムメモリは使わない。 プログラムメモリ全体を外
部にマッピングする。

マクロ ディレクティブ (Macro Directives)

マクロ定義の中で実行とデータ割り当てを制御するディレクティブ。

マクロ (Macro)

マクロ命令。 一連の命令シーケンスを短い名前で表現した命令。

マシンコード (Machine Code)

コンピュータ プログラムをプロセッサが実際に読み出して解釈できる形式で表現し
たもの。 2 進数のマシンコードで記述されたプログラムは、マシン命令のシーケンス
(命令間にデータを挟む事もある )から成る。 ある特定のプロセッサで使える全ての命
令の集合を「命令セット」という。

マシン語 (Machine Language)

ある CPU が翻訳を必要とせず実行できる命令の集合。

未割り当てセクション (Unassigned Section)

リンカのコマンドファイルで特定のターゲット メモリブロックに割り当てられてい
ないセクション。 リンカは、未割り当てセクションを割り当てるターゲット メモリブ
ロックを検出する必要がある。

命令 (Instructions)

CPUに対して特定の演算を実行するように指示するビット列。演算の対象となるデー
タを含める事もできる。

命令セット (Instruction Set)

特定のプロセッサが理解できるマシン語命令の集合。

メッセージ (Message)

言語ツールの動作に問題が発生した事を知らせる文字列。 メッセージが表示されても
処理は停止しない。

メモリモデル (Memory Model)

C コンパイラの場合、アプリケーションで利用可能なメモリを表現したもの。 PIC18
C コンパイラの場合、プログラムメモリを指し示すポインタのサイズに関する規定を
記述したもの。

モジュール (Module)

プリプロセッサ ディレクティブ実行後の前処理済みのソースファイル出力。 翻訳単
位とも呼ぶ。

や

優先順位 (Precedence)

式の評価順を定義した規則。
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読み出し専用メモリ (Read Only Memory)

恒久的に保存されているデータへの高速アクセスが可能なメモリ ハードウェア。ただ
し、データの追加または変更は不可。

ら

ライブラリ / ライブラリアン (Library/Librarian)

「アーカイブ / アーカイバ」参照。

ランタイム ウォッチ (Runtime Watch)

アプリケーション実行中に [Watches] ウィンドウで変数の値がリアルタイムに変化す
る事。 ランタイム ウォッチの設定方法は、各ツールのマニュアル参照。 ランタイム
ウォッチをサポートしていないツールもある。

ランタイムモデル (Run-time Model)

ターゲット アーキテクチャのリソースの使用を記述したもの。

リアルタイム (Real Time)

インサーキット エミュレータまたはデバッガが Halt 状態から解放されると、プロセッ
サの実行はリアルタイム モードとなり、通常のチップと同じ挙動をする。 リアルタイム
モードでは、エミュレータのリアルタイム トレースバッファが有効になり、選択した
全てのサイクルを常時キャプチャする。また、全てのブレークロジックが有効になる。
インサーキット エミュレータまたはデバッガでは、有効なブレークポイントで停止す
るか、またはユーザが実行を停止するまでプロセッサはリアルタイムで動作する。

シミュレータでは、ホスト CPU でシミュレート可能な最大速度でマイクロコントローラ
の命令を実行する事をリアルタイムと呼ぶ。

リスティング ディレクティブ (Listing Directives)

アセンブラのリスティング ファイルのフォーマットを制御するディレクティブ。 タイ
トルや改ページ指示等、リスティング ファイルに関する各種の設定を行う。

リスティング (Listing File)

ソースファイルにある各 C ソース ステートメント、アセンブリ命令、アセンブラ ディ
レクティブ、マクロに対して生成されたマシンコードを記述した ASCII テキストファ
イル。

リトル エンディアン (Little Endian)

マルチバイト データで最下位バイト (LSB) を最下位アドレスに格納するデータ並び
順方式。

量産プログラマ (Production Programmer)

デバイスを高速にプログラミングできるようにリソースを強化したプログラマ。 各種
電圧レベルでのプログラミングに対応し、プログラミング仕様に完全に準拠してい
る。 量産環境ではアプリケーション回路が組立ラインにとどまる時間をなるべく短く
する必要があるため、デバイスへの書き込み時間が特に重要である。

リンカ (Linker)

オブジェクト ファイルとライブラリを結合し、モジュール間の参照を解決して実行可
能コードを生成する言語ツール。

リンカスクリプト ファイル (Linker Script Files)

リンカのコマンドファイル。 リンカのオプションを定義し、ターゲット プラット
フォームで利用可能なメモリを記述する。

ループバック テストボード (Loop-Back Test Board)

MPLAB REAL ICE インサーキット エミュレータの動作をテストするために用いる。

レイテンシ (Latency)

イベントが発生してからその応答までの時間の長さ。
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ローカルラベル (Local Label)

マクロ内で LOCAL ディレクティブを使って定義されたラベル。 ローカルラベルは、
マクロの同一インスタンス内でのみ有効。 すなわち、LOCAL として宣言されたシン
ボルとラベルには、ENDM マクロ以降はアクセスできない。

ロジックプローブ (Logic Probes)

Microchip 社製エミュレータには、最大 14 のロジックプローブを接続できるものがあ
る。 ロジックプローブは、外部トレース入力、トリガ出力信号、+5 V、共通グランド
を提供する。

わ

ワークブック (Workbook)

MPLAB SIM シミュレータにおいて、SCL スティミュラスの生成に関する設定を保存
したもの。

割り当てセクション (Assigned Section)

リンカのコマンドファイルで特定のターゲット メモリブロックに割り当てられた
GCC コンパイラのセクション。

割り込み (Interrupt)

CPU に対する信号の一種。この信号が発生すると、現在動作中のアプリケーション
の実行を一時停止し、制御を割り込みサービスルーチン (ISR) に渡してイベントを処
理する。 ISR の実行が完了すると、通常のアプリケーションの実行を再開する。

割り込みサービス要求 (Interrupt Service Request (IRQ))

プロセッサの通常の命令実行を一時的に停止し、割り込みハンドラルーチンの実行開
始を要求するイベント。 プロセッサによっては複数の割り込み要求イベントを持ち、
優先度の異なる割り込みを処理できるものもある。

割り込みサービスルーチン (ISR)

言語ツールの場合、割り込みを処理する関数。

MPLAB IDE/MPLAB X IDE の場合、割り込みが発生すると実行されるユーザ作成コード。
通常、発生した割り込みの種類によってプログラムメモリ内の異なる位置のコードを
実行する。

割り込みハンドラ (Interrupt Handler)

割り込み発生時に専用のコードを実行するルーチン。

割り込みベクタ (Interrupt Vector)

割り込みサービスルーチンまたは割り込みハンドラのアドレス。
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